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Precautions When Displaying a Still Image

A still image may cause permanent damage to the TV screen.

WARNINGS:

Image retention, commonly known as screen burn-in, can occur on most types of television if the same image is displayed 

continuously. The most common causes of image retention are logos that remain stationary on the TV screen. These logos are 

common on many programmes received via a Setop Box.

To reduce this risk, avoid displaying still images for long durations and lower the brightness or contrast settings to decrease 

the intensity of the picture. Extended viewing of movies and programs in aspect ratios that are different from the aspect ratio 

of the TV may cause image retention. Always endeavour to avoid black borders top or bottom by using the zoom function. This 

will help eliminate the black borders and fit the picture to the entire area of the screen. Using a video game console may cause 

image retention and is not recommended. When using a PC input, avoid displaying still images for long durations and reduce the 

brightness or contrast settings to decrease the intensity of the picture.

IMPORTANT:

Image retention issues are not covered by your Samsung® warranty.

Digital TV (DVB-T) Notice

1.  FUNCTIONALITIES RELATED TO DIGITAL TV (DVB) ARE ONLY AVAILABLE IN COUNTRIES OR AREAS WHERE DVBT 

(MPEG2 AND MPEG4 AVC) DIGITAL TERRESTRIAL SIGNALS ARE BROADCAST. DVB-T is the European consortium 

standard for the broadcast transmission of digital terrestrial television. Please check with your local dealer about the 

availability of DVB-T service in your area.

2.  Although this TV set meets the current DVB-T standards as of [August, 2008], compatibility with future DVB-T digital terrestrial 

broadcast cannot be guaranteed.

3. Some Digital TV functions may not be available or operate correctly in some countries or regions.

4. For more information, please contact your local SAMSUNG customer care centre.

Precautions When Displaying a Still Image 

A still image may cause permanent damage to the TV screen

Do not display still image and partially still on the LCD panel for more than 2 hours as it can cause screen image retention. 

This image retention is also known as screen burn. To avoid such image retention, reduce the degree of brightness and 

contrast of the screen when displaying a still image.

Watching the LCD TV in 4:3 format for a long period of time may leave traces of borders displayed on the 

left, right and centre of the screen caused by the difference of light emission on the screen. Playing a DVD or 

a game console may cause a similar effect to the screen. Damages caused by the above effect are not 

covered by the Warranty.

Displaying still images from Video games and PC for longer than a certain period of time may produce partial after-images. To 

prevent this effect, reduce the ‘brightness’ and ‘contrast’ when displaying still images.  

© 2009 Samsung Electronics Co., Ltd. All rights reserved.
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License

TruSurround HD, SRS and  symbol are trademarks of SRS Labs, Inc. TruSurround HD technology is 

incorporated under license from SRS Labs, Inc.

Manufactured under license from Dolby Laboratories. Dolby and the double-D symbol are trademarks of 

Dolby Laboratories.

DivX Certified products using Home Theatre Test Kit v3.0 or later: Plays DivX® video, including premium 

content.

Symbol 
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SETTING UP YOUR TV

Figures and illustrations in this User Manual are provided for reference only and may differ from actual product appearance. 

Product design and specifications may be changed without notice in order to enhance product performance.

Viewing the Control Panel

The product colour and shape may vary depending on the model.

The front panel buttons can be activated by touching it with your finger.

1 P (POWER): Press to turn the TV on and off.

2 POWER INDICATOR: Blinks and turns off when the power is on and lights up in stand-by mode.

3 z: Press to change channels. In the on-screen menu, use the z buttons as you would use the ▼ and ▲ 
buttons on the remote control.

4 Y: Press to increase or decrease the volume. 

In the on-screen menu, use the Y buttons as you would use the ◄ and ► buttons on the remote control.
5 MENU: Press to see an on-screen menu of your TV’s features.

6 SOURCE E: Toggles between all the available input sources. In the on-screen menu, use this button as you would use the 

ENTERE button on the remote control.

7 REMOTE CONTROL SENSOR: Aim the remote control towards this spot on the TV.

8 SPEAKERS

N
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Accessories

Remote Control & Batteries (AAA x 2) Power Cord Cover-Bottom Cleaning Cloth

Stand Screw (M4 X L16)
(Depending on the model)

Programme CD
Holder-Wire Cable

(Depending on the model)

Owner's Instructions●

Please make sure the following items are included with your LCD TV. If any items are missing, contact your dealer.

The items colour and shape may vary depending on the model.

¦

N
N
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Viewing the Connection Panel

The product colour and shape may vary depending on the model.

1 COMPONENT IN 

Connects Component video / audio.

2 HDMI IN 1, 2, 3(DVI), 4 / DVI AUDIO IN

Connects to the HDMI jack of a device with an HDMI output.

No sound connection is needed for an HDMI to HDMI connection.

What is HDMI?

HDMI(High-Definition Multimedia Interface), is an interface that enables the transmission of digital audio and video signals 

using a single cable.

The difference between HDMI and DVI is that the HDMI device is smaller in size and has the HDCP (High Bandwidth 

Digital Copy Protection) coding feature installed.

The TV may not output sound and pictures may be displayed with abnormal colour when DVD / Blu-ray player / Cable 

Box / Satellite receiver (Set-Top Box) supporting HDMI versions older than 1.3 are connected. When connecting an older 

HDMI cable and there is no sound, connect the HDMI cable to the HDMI IN 3(DVI) jack and the audio cables to the DVI 

AUDIO IN jacks on the back of the TV. If this happens, contact the company that provided the DVD / Blu-ray player / 

Cable Box / Satellite receiver (Set-Top Box) to confirm the HDMI version, then request an upgrade.

Use the HDMI IN 3(DVI) jack for DVI connection to an external device. Use a DVI to HDMI cable or DVI-HDMI adapter 

(DVI to HDMI) for video connection and the DVI AUDIO IN jacks for audio. When using an HDMI / DVI cable connection, 

you must use the HDMI IN 3(DVI) jack.

HDMI cables that are not 1.3 may cause annoying flicker or no screen display.

3 PC IN [PC] / [AUDIO]

Connects to the video and audio output jacks on your PC.

If your PC supports an HDMI connection, you can connect this to the HDMI IN 1, 2, 3(DVI) or 4 terminal.

If your PC supports a DVI connection, you can connect this to the HDMI IN 3(DVI) / DVI AUDIO IN terminal.

4 ANT IN

Connects to an antenna or cable TV system.

5 LAN

Connect a LAN cable to this port to connect to the Network.

6 KENSINGTON LOCK (depending on the model)

The Kensington Lock (optional) is a device used to physically fix the system when used in a public place. If you want to use a 

locking device, contact the dealer where you purchased the TV.

The location of the Kensington Lock may be different depending on its model.
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7 H(HEADPHONE)

Headphone may be connected to the headphone output on your set. While the head phone is connected, the sound from the 

built-in speakers will be disabled.

Using the sound function is restricted when connecting headphones to the TV.

Prolonged use of headphones at a high volume may damage your hearing.

You will not hear sound from the speakers when you connect headphones to the TV.

The headphone volume and TV volume are adjusted separately.

8 DIGITAL AUDIO OUT (OPTICAL)

Connects to a Digital Audio component such as a Home theatre receiver.

When a Digital Audio System is connected to the DIGITAL AUDIO OUT (OPTICAL) jack: Decrease the volume of the TV 

and adjust the volume level with the system’s volume control.

5.1CH audio is possible when the TV is connected to an external device supporting 5.1CH.

When the receiver (home theatre) is set to On, you can hear sound output from the TV’s Optical jack. When the TV is 

displaying a DTV(air) signal, the TV will send out 5.1 channel sound to the Home theatre receiver. When the source is a 

digital component such as a DVD / Blu-ray player / Cable Box / Satellite receiver (Set-Top Box) and is connected to the 

TV via HDMI, only 2 channel sound will be heard from the Home Theatre receiver. If you want to hear 5.1 channel audio, 

connect the digital audio out jack on DVD / Blu-ray player / Cable Box / Satellite receiver (Set-Top Box) directly to an 

Amplifier or Home Theatre, not the TV.

9 SERVICE

Connector for service only.

0 AUDIO OUT [R-AUDIO-L]

Connects to the audio input jacks on your Amplifier/Home theatre.

When an audio amplifier is connected to the AUDIO OUT [R-AUDIO-L] jacks: Decrease the volume of the TV and adjust the 

volume level with the Amplifier’s volume control.

! EXT1, 2

Inputs or outputs for external devices, such as VCR, DVD, video game device or video disc players.

In EXT Mode, DTV Out supports MPEG SD Video and Audio only.

Input/Output Specification

Connector
Input Output

Video Audio (L / R) RGB Video + Audio (L / R)
EXT 1 O O O Only TV or DTV output is available.
EXT 2 O O X Output you can choose.

@ AV IN [VIDEO] / [R-AUDIO-L]

Video and audio inputs for external devices, such as a camcorder or VCR.

# USB1(HDD) / USB2

Connector for software upgrades and Media Play, etc. 

You can connect to Samsung’s network wirelessly using the ‘Samsung Wireless LAN Adapter’ (Sold separately).

For USB HDD, use the USB1 (HDD) port.

$ COMMON INTERFACE Slot

When not inserting ‘CI CARD’ in some channels, ‘Scrambled Signal’ is displayed on the screen.

The pairing information containing a telephone number, CI CARD ID, Host ID and other information will be displayed in 

about 2~3 minutes. If an error message is displayed, please contact your service provider.

When the channel information configuration has finished, the message ‘Updating Completed’ is displayed, indicating that 

the channel list is now updated.

You must obtain a CI CARD from a local cable service provider. Remove the CI CARD by carefully pulling it out with your 

hands since dropping the CI CARD may cause damage to it.

Insert the CI-Card in the direction marked on it.

The place of the COMMON INTERFACE Slot may be different depending on its model. 

CAM is not supported in some countries and regions, check with your authorized dealer.

N
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Viewing the Remote Control

You can use the remote control up to a distance of about 23 feet from the TV.

The performance of the remote control may be affected by bright light.

The product colour and shape may vary depending on the model.

1 POWER : Turns the TV on and 

off.

2 TV : Selects the TV mode 

directly.

3 NUMERIC BUTTONS :  Press to 

change the channel.

4 E : Performs the same function 

as the ENTERE button of 

the directional buttons. When 

switching channels with the 

numeric buttons, and you press 

the channel number and then the 

ENTERE button, the channel is 

immediately switched.

5 Y : Press to increase or 
decrease the volume.

6 SOURCE : Press to display 

and select the available video 

sources.

7 CH LIST : Used to display 

Channel Lists on the screen.

8 TOOLS : Use to quickly select 

frequently used functions.

9 INTERNET@ : Press to use 

various internet services to 

view useful information and 

entertaining content.

0 COLOURS BUTTONS : Use 

these buttons in the Channel 

list, Internet@TV, Media Play 

menu, etc.

@ INFO : Press to display 

information on the TV screen.

# Use these buttons in the DMA, 

Media Play and Anynet+ modes. 

(∏: This remote can be used 

to control recording on Samsung 

recorders with the Anynet+ 

feature)

$ ON/OFF @: Pressing the 

ON/OFF @ light button toggles 

between on and off. When the 

remote control is on, and a button 

is pressed on the remote control, 

the remote control buttons will 

be lit for a moment. (Using the 

remote control with the ON/OFF 

@ light button set to On will 

reduce the battery usage time.)

% PRE-CH : Enables you to return 

to the previous channel you were 

watching.

^ MUTE M : Press to temporarily 

cut off the sound. 

& > P < : Press to change 

channels.

* MENU : Displays the main  

on-screen menu.

( FAV.CH : Used to display 

Favourites channel Lists on the 

screen.

) RETURN : Returns to the 

previous menu

a	 UP▲	/	DOWN▼	/	LEFT◄	/	
RIGHT►	/	ENTERE : Use to 

select on-screen menu items and 

change menu values.

b EXIT : Press to exit the menu.

c CONTENT : This function 

enables you to view the Content 

Library.

d MEDIA.P : Allows you to play 

music files, pictures, and movies.

e SUBT. : Digital subtitle display

f GUIDE : Electronic Programme 

Guide (EPG) display

Teletext Functions

6 0 : Teletext mode selection 

(LIST / FLOF)

7 8 : Teletext store

8 4 : Teletext size selection

0 Fastext topic selection

! / : Alternately select 

Teletext, Double, or Mix.

@ 5 : Teletext reveal

$ : : Exit from the Teletext 

display

% 1 : Teletext sub page

& 2 : Teletext next page

3 : Teletext previous page

* 6 : Teletext index

) 9 : Teletext hold

b 7 : Teletext cancel

¦
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Installing Batteries in the Remote Control

1. Lift the cover at the back of the remote control upward as shown in the figure.

2. Install two AAA size batteries. 

Make sure to match the ‘+’ and ‘–’ ends of the batteries with the diagram inside the 

compartment.

3. Replace the cover.

Remove the batteries and store them in a cool, dry place if you won’t be using the 

remote control for a long time. 

If the remote control doesn’t work, check the following:

Is the TV power on? 

Are the plus and minus ends of the batteries reversed?

Are the batteries drained?

Is there a power outage or is the power cord unplugged?

Is there a special fluorescent light or neon sign nearby?OPERATION

Viewing the menus

Before using the TV, follow the steps below to learn how to navigate the menu in order to select and adjust different functions.

  

Operation of the OSD (On Screen Display)

The access step may differ depending on the selected menu.

1. Press the MENU button.

2. The main menu appears on the screen. The menu’s left side has icons : Picture, Sound, 

Channel, Setup, Input, Application, Support.

3. Press the ▲ or ▼ button to select one of the icons.

4. Then press the ENTERE button to access the icon’s sub-menu.

�. Press the ▲ or ▼ button to select the icon’s submenu.

�. Press the ◄ or ► button to decrease or increase the value of a particular item. The 
adjustment OSD may differ depending on the selected menu.

�. Press the ENTERE button to complete the configuration. Press the EXIT button to exit.

¦

N

N
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¦

❑

MENU Button

Display the main on-screen menu.

ENTERE / DIRECTION Button

Move the cursor and select an 

item. Select the currently selected 

item. Confirm the setting.

RETURN Button

Return to the previous menu.

EXIT

Exit the on-screen menu.

Mode	 :	Standard	 ▶

Backlight	 :	7
Contrast	 :	95
Brightness	 :	45
Sharpness	 :	50
Colour	 :	50
Tint	(G/R)	 :	G50/R50
Advanced	Settings

Picture

Mode	 :	Standard

Backlight	 :	7	 ▶

Contrast	 :	95
Brightness	 :	45
Sharpness	 :	50
Colour	 :	50
Tint	(G/R)	 :	G50/R50
Advanced	Settings
Picture	Options

Picture

7

 U	Move				L	Adjust					E	Enter					R	Return

						▲
Backlight
						▼

Help icon
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Plug & Play Feature

When the TV is initially powered on, basic settings proceed automatically and subsequently.

1. Press the POWER button on the remote control. 

You can also use the POWERP button on the TV. 

The message Select the OSD Language. is displayed.

2. Press the ENTERE button. Select the appropriate language by pressing the ▲ or ▼ 
button. Press the ENTERE button to confirm your choice.

3. Press the ◄ or ► button to select Store Demo or Home Use, then the ENTERE button.

We recommend setting the TV to Home Use mode for the best picture in your home 

environment.

Store Demo mode is only intended for use in retail environments.

If the unit is accidentally set to Store Demo mode and you want to return to Home 

Use (Standard): Press the volume button on the TV. When the volume OSD is displayed, press and hold the MENU 

button on the TV for 5 seconds.

4. Press the ENTERE button. Select the appropriate country by pressing the ▲ or ▼ button. Press the ENTERE button to 

confirm your choice.

�. Press the ▲ or ▼ button to select Air or Cable, then press the ENTERE button.

Air: Air antenna signal.

Cable: Cable antenna signal.

�. Press the ▲ or ▼ button to select the channel source to memorize. Press the ENTERE button to select Start.

When setting the antenna source to Cable, a step appears allowing you to set a value for the digital channel search. For 

more information, refer to Channel	→	Auto	Store.

Digital & Analogue: Digital and Analogue channels.

Digital: Digital channels.

Analogue: Analogue channels.

The channel search will start and end automatically.

Press the ENTERE button at any time to interrupt the memorization process.

After all the available channels are stored, the message Set the Clock Mode. is displayed.

�. Press the ENTERE button. Press the ▲ or ▼ button to select Auto, then Press the ENTERE button.

If you select Manual, Set current date and time is displayed. 

If you have received a digital signal, the time will be set automatically. If not, select Manual to set the clock.

�. The description for the connection method providing the best HD screen quality is displayed. Check the description and press 

the ENTERE button.

9. Press the ◄ or ► button to select See Product Guide or Watch TV. Press the ENTERE button.

See Product Guide: You are moved to the Product Guide where you can view the introduction to the main functions of 

your new HDTV.

Watch TV: You can watch the memorized channels.

If you want to reset this feature...

1. Press the MENU button to display the menu. Press the ▲ or ▼ button to select Setup, 

then press the ENTERE button.

2. Press the ENTERE button again to select Plug & Play.

3. Enter your 4 digit PIN number. The default PIN number of a new TV set is ‘0-0-0-0’.

If you want to change PIN number, use the Change PIN function. 

The Plug & Play feature is only available in the TV mode.

¦
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Plug	&	Play	 	 ▶

Language	 :	English
Time
Game	Mode	 :	Off
BD	Wise	 :	Off
Network	Type	 :	Cable
Network	Setup
Child	Lock	 :	On

Setup
Select	the	OSD	Language.

Menu	Language		 :	English		 	 ▶

E	Enter

Plug	&	Play
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CHANNEL

Channel Menu

Country

Analogue Channel

You can change the country for analogue channels.

Digital Channel

You can change the country for digital channels.

The PIN number input screen appears. Enter your 4 digit PIN number.

Auto Store

You can scan for the frequency ranges available to you (and availability depends on your country). Automatically allocated 

programme numbers may not correspond to actual or desired programme numbers.

If a channel is locked using the Child Lock function, the PIN input window appears.

Air / Cable

Antenna source to memorize

Digital & Analogue: Digital and Analogue channels.

Digital: Digital channels.

Analogue: Analogue channels.

When selecting Cable	→	Digital	&	Analogue or Cable	→	Digital:
Provide a value to scan for cable channels.

Search	Mode	→	Full	/	Network	/Quick
Quick

Network ID: Displays the network identification code.

Frequency: Displays the frequency for the channel. (Differs in each country)

Modulation: Displays available modulation values.

Symbol Rate: Displays available symbol rates.

Scans for all channels with active broadcast stations and stores them in the TV’s memory.

If you want to stop Auto Store, press the ENTERE button.

The Stop Auto Store? message will be displayed.

Select Yes by pressing the ◄ or ► button, then press the ENTERE button.

Manual Store

Scans for a channel manually and stores it in the TV’s memory.

If a channel is locked using the Child Lock function, the PIN input window appears.

Digital Channel

Manual store for digital channels.

Digital Channel is only available in DTV mode.

Channel: Set the Channel number using the ▲, ▼ or number (0~9) buttons.
Frequency: Set the frequency using the number buttons.

Bandwidth: Set the bandwidth using the ▲, ▼ or number (0~9) buttons.
When it has finished, channels are updated in the channel list.

Analogue Channel

Manual store for analogue channel.

Programme (Programme number to be assigned to a channel): Sets the programme number using the ▲, ▼ or number (0~9) 
buttons.

Colour	System	→	Auto	/	PAL	/	SECAM	/	NTSC4.43: Sets the colour system value using the ▲ or ▼ button.
Sound	System	→	BG	/	DK	/	I	/	L: Sets the sound system value using the ▲ or ▼ button.
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Country	 	 ▶

Auto	Store
Manual	Store
Cable	Search	Option
Full	Guide
Mini	Guide
Default	Guide	 :	Full	Guide
Channel	List

Channel
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Channel (When you know the number of the channel to be stored): Press the ▲ or ▼ button to select C (Air channel) or S 

(Cable channel). Press the ► button, then press the ▲, ▼ or number (0~9) buttons to select the required number.
You can also select the channel number directly by pressing the number (0~9) buttons.

If there is abnormal sound or no sound, reselect the sound standard required.

Search (When you do not know the channel numbers): Press the ▲ or ▼ button to start the search. The tuner scans the 
frequency range until the first channel or the channel that you selected is received on the screen.

Store (When you store the channel and associated programme number): Set to OK by pressing the ENTERE button.

Channel mode

P (Programme mode): When completing tuning, the broadcasting stations in your area have been assigned to position 

numbers from P00 to P99. You can select a channel by entering the position number in this mode.

C (Air channel mode): You can select a channel by entering the assigned number to each air broadcasting station in this 

mode.

S (Cable channel mode): You can select a channel by entering the assigned number for each cable channel in this mode.

Cable Search Option (depending on the country)

Using this function, you can manually add the channel range to be scanned by Full Search mode of the Auto Store function.

Freq.Start (Frequency Start): Set the start frequency  (Differs in each country)

Freq.Stop (Frequency Stop): Set the stop frequency (Differs in each country)

Modulation: Displays available modulation values.

Symbol Rate: Displays available symbol rates.

Full Guide / Mini Guide

The EPG (Electronic Programme Guide) information is provided by the broadcasters. Programme entries may appear blank or out 

of date as a result of the information broadcast on a given channel. The display will dynamically update as soon as new information 

becomes available.

You can also display the guide menu simply by pressing the GUIDE button. (To configure the Default Guide, refer to the 

descriptions.)

Full Guide

Displays the programme information as time ordered One hour segments. Two hours of programme information is displayed which 

may be scrolled forwards or backwards in time.

Mini Guide

The information of each programme is displayed by each line on the current channel Mini Guide screen from the current 

programme onwards according to the programme starting time order.

Default	Guide	→	Mini	Guide	/	Full	Guide
You can decide whether to display either the Mini Guide or the Full Guide when the GUIDE button on the remote control is 

pressed.

Channel List

For detailed procedures on using the Channel List, refer to the ‘Managing Channels’ instructions.

You can select these options by simply pressing the CH LIST button on the remote control.

Channel Mode

When press the P >/< button, Channels will be switched within the selected channel list.

Added Ch.

Channels will be switched within the memorized channel list.

Favourite Ch.

Channels will be switched within the favourite channel list.
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Fine Tune

If the reception is clear, you do not have to fine tune the channel, as this is done automatically during the search and store 

operation. If the signal is weak or distorted, you may have to fine tune the channel manually.

Fine tuned channels that have been saved are marked with an asterisk “*” on the right-hand side of the channel number in the 

channel banner.

To reset the fine-tuning, select Reset by pressing the ▲ or ▼ button and then press the ENTERE button.

Only Analogue TV channels can be fine tuned.

Using the Full / Mini Guide

To... Then...

Watch a programme in the EPG list Select a programme by pressing the ▲, ▼, ◄, ► button.

Exit the guide Press the blue button

If the next programme is selected, it is scheduled with the clock icon displayed. If the ENTERE button is pressed again, press 

the ◄, ► button to select Cancel Schedules, the scheduling is cancelled with the clock icon gone. 

View programme information Select a programme of your choice by pressing the ▲, ▼, ◄, ► button. 
Then press the INFO button when the programme of your choice is 

highlighted.

The programme title is on the upper part of the screen centre. 

Please click on INFO button for the detailed information. Channel Number, Running Time, Status Bar, Parental Level, Video Quality 

Information (HD / SD), Sound Modes, Subtitle or Teletext, languages of Subtitle or Teletext and brief summary of the highlighted 

programme are included on the detailed information. “...” will be appeared if the summary is long.

Toggle between the Mini Guide and Full Guide Press the red button repeatedly.

In Full Guide 

Scrolls backwards quickly (24 hours). 

Scrolls forwards quickly (24 hours).

Press the Green button repeatedly.

Press the Yellow button repeatedly.

In Mini Guide

Display previous page quickly.

Display next page quickly.

Press the Green button.

Press the Yellow button.
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Full	Guide

E	Watch				 	Information				 	Mini	Guide				 	+24	Hours				 	Exit

DTV	Cable	900	f	tn																									2:10	Tue	1	Jun
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904							oneword
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		900
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▼

2009-02-13    9:52:16



English - 12

Managing Channels 

Using this menu, you can add / delete or set favourites channels and use the programme guide for digital broadcasts.

All Channels

Shows all currently available channels.

Added Channels

Shows all added channels.

Favourites

Shows all favourite channels.

To select the favourites channels you have set up, press the FAV.CH button on the remote 

control.

Programmed

Shows all current reserved programmes.

Select a channel in the All Channels, Added Channels or Favourites screen by pressing the ▲ / ▼ buttons, and pressing 
the ENTERE button. Then you can watch the selected channel.

Using the Colour buttons with the Channel List

Red (Channel Type): Toggle between your TV, Radio, Data / Other and All.

Green (Zoom): Enlarges or shrinks a channel number.

Yellow (Select): Selects multiple channel lists. You can perform the add/delete or add to favourites/delete from favourites 

function for multiple channels at the same time. Select the required channels and press the Yellow button to set all the 

selected channels at the same time.  The c mark appears to the left of the selected channels.

TOOLS (Tools): Displays the Delete (or Add), Add to Favourite (or Delete from Favourite), Lock (or Unlock), Timer 

Viewing, Edit Channel Name, Edit Channel Number, Sort, Select All, Deselect All or Auto Store menu. (The Options 

menus may differ depending on the situation.)

Channel Status Display Icons

A: An Analogue channel.

c: A channel selected by pressing the Yellow button.

*: A channel set as a Favourite.

(: A programme currently being broadcast.

\: A locked channel.

): A reserved programme

Channel List Option Menu (in All Channels / Added Channels / Favourites)

Press the TOOLS button to use the option menu.

Option menu items may differ depending on the channel status.

Add / Delete

You can delete or add a channel to display the channels you want.

All deleted channels will be shown on All Channels menu.

A gray-coloured channel indicates the channel has been deleted.

The Add menu only appears for deleted channels.

You can also delete a channel to the Added Channels or Favourites menu in the same 

manner.

Add to Favourite / Delete from Favourite

You can set channels you watch frequently as favourites.

Press the TOOLS button to display the Tools menu. You can also set the add to (or delete from) Favourite by selecting Tools 

→	Add	to	Favourite (or Delete from Favourite).

The “*” symbol will be displayed and the channel will be set as a favourite.

All favourite channels will be shown on Favourites menu.
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825										UKTV	style

A 1					C	--
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Delete
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Lock / Unlock

You can lock a channel so that the channel cannot be selected and viewed. 

This function is available only when the Child Lock is set to On. 

The PIN number input screen appears. Enter your 4 digit PIN number.

The default PIN number of a new TV set is “0-0-0-0”. You can change the PIN, by selecting Change PIN from the menu.

The “\” symbol will be displayed and the channel will be locked.

Timer Viewing

If you reserve a programme you want to watch, the channel is automatically switched to the reserved channel in the Channel List; 

even when you are watching another channel. To reserve a programme, set the current time first. 

Only memorized channels can be reserved.

You can set the channel, day, month, year, hour and minute directly by pressing the number buttons on the remote control.

Reserving a programme will be shown in the Programmed menu.

Digital Programme Guide and Viewing Reservation

When a digital channel is selected, and you press the ► button, the Programme Guide for the channel appears. You can 
reserve a programme according to the procedures described above.

Edit Channel Name (analogue channels only)

Channels can labelled so that their call letters appear whenever the channel is selected.

The names of digital broadcasting channels are automatically assigned and cannot be renamed.

Edit Channel Number (digital channels only)

You can also edit the channel number by pressing the number buttons on the remote control.

Sort (analogue channels only)

This operation allows you to change the programme numbers of the stored channels. This operation may be necessary after using 

the auto store.

Select All / Deselect All

Select All: You can select all the channels in the channel list.

Deselect All: You can deselect all the selected channels.

You can only select Deselect All when there is a selected channel.

Auto Store

For detailed procedures on setting up options, refer to the ‘Channel Menu’ instructions.

If a channel is locked using the Child Lock function, the PIN input window appears.

Channel List Option Menu (in Programmed)

You can view, modify or delete a reservation.

Press the TOOLS button to use the option menu.

Change Info

Select to change a viewing reservation.

Cancel Schedules

Select to cancel a viewin`g reservation.

Information

Select to view a viewing reservation. 

(You can also change the reservation information.)

Select All

Select all reserved programmes.
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PICTURE

Configuring the Picture Menu

Mode

You can select the type of picture which best corresponds to your viewing requirements.

Press the TOOLS button to display the Tools menu. You can also set the picture mode by 

selecting Tools	→	Picture	Mode.

Dynamic

Selects the picture for increased definition in a bright room.

Standard

Selects the picture for the optimum display in a normal environment.

Natural

Selects the picture for an optimum and eye-comfortable display.

Movie

Selects the picture for viewing movies in a dark room.

Backlight / Contrast / Brightness / Sharpness / Colour / Tint(G/R)

Your television has several setting options that allow you to control the picture quality.

Backlight: Adjusts the brightness of LCD back light.

Contrast: Adjusts the contrast level of the picture.

Brightness: Adjusts the brightness level of the picture

Sharpness: Adjusts the edge definition of the picture.

Colour: Adjusts colour saturation of the picture.

Tint(G/R): Adjusts the colour tint of the picture.

In analogue TV, Ext., AV modes of the PAL system, you cannot use the Tint(G/R) Function.

When you make changes to Backlight, Contrast, Brightness, Sharpness, Colour or Tint(G/R) the OSD will be adjusted 

accordingly.

In PC mode, you can only make changes to Backlight, Contrast and Brightness.

Settings can be adjusted and stored for each external device you have connected to an input of the TV.

The energy consumed during use can be significantly reduced if the brightness level of the picture is lowered, which will 
reduce the overall running cost.

Advanced Settings

Samsung’s new TVs allow you to make even more precise picture settings than previous 

models. 

Advanced Settings is available in Standard or Movie mode.

In PC mode, you can only make changes to Dynamic Contrast, Gamma and White 

Balance from among the Advanced Settings items.

Black	Tone	→	Off	/	Dark	/	Darker	/	Darkest
You can select the black level on the screen to adjust the screen depth.

Dynamic	Contrast	→	Off	/	Low	/	Medium	/	High
You can adjust the screen contrast so that the optimal contrast is provided.

Gamma

You can adjust the primary colour (red, green, blue) intensity.
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Backlight	 :	7
Contrast	 :	95
Brightness	 :	45
Sharpness	 :	50
Colour	 :	50
Tint	(G/R)	 :	G50/R50
Advanced	Settings

Picture

7

 U	Move				L	Adjust					E	Enter					R	Return

						▲
Backlight
						▼

Black	Tone	 :	Off	 	 ▶
Dynamic	Contrast	 :	Medium
Gamma	 :	0
Colour	Space	 :	Native
White	Balance
Flesh	Tone	 :	0
Edge	Enhancement	 :	On

U	Move					E	Enter					R	Return

Advanced	Settings
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Colour Space

Colour space is a colour matrix composed of red, green and blue colours. Select your favourites colour space to experience the 

most natural colour.

Auto: Auto Colour Space automatically adjusts to the most natural colour tone based on program sources.

Native: Native Colour Space offers deep and rich colour tone.

Custom: Adjusts the colour range to suit your preference.

Changing the adjustment value will refresh the adjusted screen.

Settings can be adjusted and stored for each external device you have connected to an input of the TV. For example, if 

you have a DVD player connected to HDMI 1 and it is currently selected, settings and adjustments will be saved for the 

DVD player. 

Colour: Red, Green, Blue, Yellow, Cyan or Magenta

Colour is available when Colour Space is set to Custom.

In Colour, you can adjust the RGB values for the selected colour.

To reset the adjusted RGB value, select Reset.

Red: Adjusts the red saturation level of the selected colour.

Green: Adjusts the green saturation level of the selected colour.

Blue: Adjusts the blue saturation level of the selected colour.

Reset: Resets the colour space to the default values.

White Balance

You can adjust the colour temperature for more natural picture colours.

R-Offset: Adjusts the red colour darkness.

G-Offset: Adjusts the green colour darkness.

B-Offset: Adjusts the blue colour darkness.

R-Gain: Adjusts the red colour brightness.

G-Gain: Adjusts the green colour brightness.

B-Gain: Adjusts the blue colour brightness.

Reset: The previously adjusted white balance will be reset to the factory defaults.

Flesh Tone

You can emphasize the pink ‘flesh tone’ in the picture.

Changing the adjustment value will refresh the adjusted screen.

Edge	Enhancement	→	Off	/	On
You can emphasize object boundaries in the picture.

xvYCC	→	Off	/	On
Setting the xvYCC mode to on increases detail and colour space when watching movies from an external device (ie. DVD player) 

connected to the HDMI or Component IN jacks.

xvYCC is available when the picture mode is set to Movie, and the external input is set to HDMI or Component mode.
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Picture Options

In PC mode, you can only make changes to the Colour Tone and Size from among the 

items in Picture Options.

Colour	Tone	→	Cool	/	Normal	/	Warm1	/	Warm2	/	Warm3
Warm1, Warm2 or Warm3 is only activated when the picture mode is Movie.

Settings can be adjusted and stored for each external device you have connected to an 

input of the TV.

Size

Occasionally, you may want to change the size of the image on your screen. Your TV comes 

with several screen size options, each designed to work best with specific types of video input. Your cable box/satellite receiver 

may have its own set of screen sizes as well. In general, though, you should view the TV in 16:9 mode as much as possible.

Press the TOOLS button to display the Tools menu. You can also set the size by selecting Tools	→	Picture	Size.

Auto Wide: Automatically adjusts the picture size to the 1�:9 aspect ratio.

1�:9: Adjusts the picture size to 16:9 appropriate for DVDs or wide broadcasting.

Wide Zoom: Magnify the size of the picture more than 4:3.

Zoom: Magnifies the 16:9 wide picture (in the vertical direction) to fit the screen size.

4:3: This is the default setting for a video movie or normal broadcasting.

Screen Fit: Use the function to see the full image without any cut-off when HDMI (720p / 1080i / 1080p) or Component (1080i 

/ 1080p) signals are input.

Depending on the input source, the picture size options may vary.

The items available may differ depending on the selected mode.

In PC Mode, only 1�:9 and 4:3 mode can be adjusted.

Settings can be adjusted and stored for each external device you have connected to an input of the TV.

Temporary image retention may occur when viewing a static image on the set for more than two hours.

Wide Zoom: Press the ► button to Select Position, then press the ENTERE button. Press the ▲ or ▼ button to move the 
picture up / down. Then press the ENTERE button.

Zoom: Press the ► button to Select Position, then press the ENTERE button. Press the ▲ or ▼ button to move the picture 
up and down. Then press the ENTERE button. Press the ► button to Select Size, then press the ENTERE button. Press 

the ▲ or ▼ button to magnify or reduce the picture size in the vertical direction. Then press the ENTERE button.

After selecting Screen Fit in HDMI (1080i / 1080p) or Component (1080i / 1080p) mode: Select Position by pressing the ◄ 
or ► button. Use the ▲, ▼, ◄ or ► button to move the picture.

Reset: Press the ◄ or ► button to select Reset, then press the ENTERE button. You can initialize the setting.

If you use the Screen Fit function with HDMI 720p input, 1 line will be cut at the top, bottom, left and right as in the Overscan 

function.

When Double (À, Œ) mode has been set in PIP, the Picture Size cannot be set.

Screen	Mode	→	16:9	/	Wide	Zoom	/	Zoom	/	4:3
When setting the picture size to Auto Wide in a 16:9 wide TV, you can determine the picture size you want to see the 4:3 WSS 

(Wide Screen Service) image or nothing. Each individual European country requires different picture size so this function is 

intended for users to select it.

1�:9: Sets the picture to 16:9 wide mode.

Wide Zoom: Magnify the size of the picture more than 4:3.

Zoom: Magnify the size of the picture vertically on screen.

4:3: Sets the picture to 4:3 normal mode.

This function is available in Auto Wide mode.

This function is not available in PC, Component or HDMI mode.

Digital	NR	→	Off	/	Low	/	Medium	/	High	/	Auto
If the broadcast signal received by your TV is weak, you can activate the Digital Noise Reduction feature to help reduce any static 

and ghosting that may appear on the screen.

When the signal is weak, select one of the other options until the best picture is displayed.

HDMI	Black	Level	→	Normal	/	Low
You can select the black level on the screen to adjust the screen depth.

This function is active only when an external device is connected to the TV via HDMI (RGB signals).

❑

N

■

N
N

■

T
●
●
●
●
●
●

N
N
N
N
N
N

N

N

�
N

N

■

●
●
●
●
N
N

■

N

■

N

Colour	Tone	 :	Normal	 	 ▶
Size	 :	Auto	Wide
Screen	Mode	 :	16:9
Digital	NR	 :	Auto
HDMI	Black	Level	 :	Normal
Film	Mode	 :	Off
100Hz	Motion	Plus	 :	Standard
	 ▼

U	Move					E	Enter					R	Return

Picture	Options

2009-02-13    9:52:17



English - 1�

Film	Mode	→	Off	/	Auto1	/	Auto2
The TV can be set to automatically sense and process film signals from all sources and adjust the picture for optimum quality.

Film Mode is supported in TV, AV, COMPONENT(480i / 1080i) and HDMI(480i / 1080i).

Off: Turn the Film Mode function off.

Auto1: Automatically adjusts the picture for the best quality when watching a film.

Auto2: Automatically optimizes the video text on the screen (not including closed captions) when watching a film.

100Hz	Motion	Plus	→	Off	/	Clear	/	Standard	/	Smooth	/	Custom	/	Demo
Removes drag from fast scenes with a lot of movement to provide a clearer picture.

If you enable 100 Hz Motion Plus, noise may appear on the screen. If this occurs, set 100Hz Motion Plus to Off.

Off: Switches 100Hz Motion Plus off.

Clear: Sets 100Hz Motion Plus to minimum.

Standard: Sets 100Hz Motion Plus to medium.

Smooth: Sets 100Hz Motion Plus to maximum.

Custom: Adjusts the blur and judder reduction level to suit your preference.

Blur Reduction: Adjusts the blur reduction level from video sources.

Judder Reduction: Adjusts the judder reduction level from video sources when playing films.

Reset: Reset the custom settings.

Demo: Displays the difference between 100Hz Motion Plus on and off modes.

Blue	Only	Mode	→	Off	/	On
This function is for AV device measurement experts. This function displays the blue signal only by removing the red and green 

signals from the video signal so as to provide a Blue Filter effect that is used to adjust the Colour and Tint of video equipment such 

as DVD players, Home Theatres, etc. Using this function, you can adjust the Colour and Tint to preferred values appropriate to 

the signal level of each video device using the Red / Green / Blue / Cyan / Magenta / Yellow Colour Bar Patterns, without using an 

additional Blue Filter.

Blue Only Mode is available when the picture mode is set to Movie or Standard.

Picture	Reset	→	Reset	Picture	Mode	/	Cancel
Resets all picture settings to the default values.

Reset Picture Mode: Current picture values return to default settings.
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Viewing Picture-in-Picture

You can use the PIP feature to simultaneously watch the TV tuner and one external video 

source. This product has one built-in tuner, which does not allow PIP to function in the same 

mode. Please see ‘PIP Settings’ below for details.

Press the TOOLS button to display the Tools menu. You can also configure PIP related 

settings by selecting Tools	→	PIP.

If you select the PIP picture sound, refer to the ‘Configuring the Sound Menu’ instructions.

PIP Settings

Main picture Sub picture

Component

HDMI1, HDMI2, HDMI3/DVI, HDMI4

PC

TV

If you turn the TV off while watching in PIP mode and turn it on again, the PIP window will disappear.

You may notice that the picture in the PIP window becomes slightly unnatural when you use the main screen to view a game 

or karaoke.

While Internet@TV is in operation, the PIP function cannot be used.

PIP	→	Off	/	On
You can activate or deactivate the PIP function. 

Size	→	Õ / Ã / À / Œ
You can select a size of the sub-picture.

Position	→	Ã / – / — / œ
You can select a position of the sub-picture.

In Double (Œ, À) mode, Position cannot be selected.

Channel

You can select the channel for the sub-screen.
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Melody	 :	Medium
Energy	Saving	 :	Off

PIP	 	 ▶

Common	Interface

Setup

PIP	 :	On	 	 ▶
Size	 :	Õ
Position	 :	Ã
Channel	 :	ATV	4
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2009-02-13    9:52:17



English - 19

Using Your TV as a Computer (PC) Display

Setting Up Your PC Software (Based on Windows XP)

The Windows display-settings for a typical computer are shown below. The actual screens on 

your PC will probably be different, depending upon your particular version of Windows and 

your particular video card. However, even if your actual screens look different, the same basic 

set-up information will apply in almost all cases. (If not, contact your computer manufacturer or 

Samsung Dealer.)

1. First, click on ‘Control Panel’ on the Windows start menu.

2. When the control panel window appears, click on ‘Appearance and Themes’ and a display 

dialog-box will appear.

3. When the control panel window appears, click on ‘Display’ and a display dialogbox will 

appear.

4. Navigate to the ‘Settings’ tab on the display dialog-box.

The correct size setting (resolution) - Optimum: 1920 X 1080 pixels

If a vertical-frequency option exists on your display settings dialog box, the correct 

value is ‘60’ or ‘60 Hz’. Otherwise, just click ‘OK’ and exit the dialog box.

Display Modes

If the signal from the system equals the standard signal mode, the screen is adjusted automatically. If the signal from the system 

doesn’t equal the standard signal mode, adjust the mode by referring to your videocard user guide; otherwise there may be no 

video. For the display modes listed on the next page, the screen image has been optimized during manufacturing.

D-Sub and HDMI/DVI Input

Mode Resolution
Horizontal Frequency 

(KHz)
Vertical Frequency 

(Hz)
Pixel Clock Frequency 

(MHz)
Sync Polarity 

(H / V)

IBM
 640 x 350 31.469 70.086 25.175 +/-
 720 x 400 31.469 70.087 28.322 -/+

MAC
 640 x 480 35.000 66.667 30.240 -/-
832 x 624 49.726 74.551 57.284 -/-
1152 x 870 68.681 75.062 100.000 -/-

VESA CVT

720 x 576 35.910 59.950 32.750 -/+
1152 x 864 53.783 59.959 81.750 -/+
1280 x 720 44.772 59.855 74.500 -/+
1280 x 720 56.456 74.777 95.750 -/+
1280 x 960 75.231 74.857 130.000 -/+

VESA DMT

640 x 480 31.469 59.940 25.175 -/-
640 x 480 37.861 72.809 31.500 -/-
640 x 480 37.500 75.000 31.500 -/-
800 x 600 37.879 60.317 40.000 +/+
800 x 600 48.077 72.188 50.000 +/+
800 x 600 46.875 75.000 49.500 +/+

1024 x 768 48.363 60.004 65.000 -/-
1024 x 768 56.476 70.069 75.000 -/-
1024 x 768 60.023 75.029 78.750 +/+
1152 x 864 67.500 75.000 108.000 +/+

1280 x 1024 63.981 60.020 108.000 +/+
1280 x 1024 79.976 75.025 135.000 +/+
1280 x 800 49.702 59.810 83.500 -/+ 
1280 x 800 62.795 74.934 106.500 -/+ 
1280 x 960 60.000 60.000 108.000 +/+
1360 x 768 47.712 60.015 85.500 +/+
1440 x 900 55.935 59.887 106.500 -/+ 
1440 x 900 70.635 74.984 136.750 -/+
1680 x 1050 65.290 59.954 146.250 -/+ 

VESA GTF
1280 x 720 52.500 70.000 89.040 -/+ 
1280 x 1024 74.620 70.000 128.943 -/-

VESA DMT / 
DTV CEA

1920 x 1080p 67.500 60.000 148.500 +/+

When using an HDMI / DVI cable connection, you must use the HDMI IN 3(DVI) jack.

The interlace mode is not supported.

The set might operate abnormally if a non-standard video format is selected.

Separate and Composite modes are supported. SOG is not supported.

Too long or low quality VGA cable can cause picture noise at high resolution modes (1920x1080).
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Setting up the TV with your PC

Preset: Press the SOURCE button to select PC mode.

Auto Adjustment

Use the Auto Adjust function to have the TV automatically adjust the video signals it receives.

The function also automatically fine-tunes the settings and adjusts the frequency values and 

positions.

Press the TOOLS button to display the Tools menu. You can also set the Auto Adjustment 

by selecting Tools	→	Auto	Adjustment.
This function does not work in DVI-HDMI mode.

Screen

Coarse / Fine

The purpose of picture quality adjustment is to remove or reduce picture noise. If the noise is 

not removed by Fine-tuning alone, then adjust the frequency as best as possible (Coarse) and 

Fine-tune again. After the noise has been reduced, readjust the picture so that it is aligned on 

the centre of screen.

PC Position

Adjust the PC’s screen positioning if it does not fit the TV screen. 

Press the ▲ or ▼ button to adjusting the Vertical-Position. Press the ◄ or ► button to adjust 
the Horizontal-Position.

Image Reset

You can replace all image settings with the factory default values.
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SOUND

Configuring the Sound Menu

Mode	→	Standard	/	Music	/	Movie	/	Clear	Voice	/	Custom
Press the TOOLS button to display the Tools menu. You can also set the sound mode by 

selecting Tools	→	Sound	Mode.

Standard: Selects the normal sound mode.

Music: Emphasizes music over voices.

Movie: Provides the best sound for movies.

Clear Voice: Emphasizes voice over other sounds.

Custom: Recalls your customized sound settings.

Equalizer

The sound settings can be adjusted to suit your personal preferences.

Mode: Selects the sound mode among the predefined settings.

Balance L/R: Adjusts the balance between the right and left speaker.

100Hz / 300Hz / 1KHz / 3KHz / 10KHz (Bandwidth Adjustment): To adjust the level of different bandwidth frequencies.

Reset: Resets the equalizer settings to the default values.

SRS	TruSurround	HD	→	Off	/	On
SRS TruSurround HD is a patented SRS technology that solves the problem of playing 5.1 multichannel content over two 

speakers. TruSurround delivers a compelling, virtual surround sound experience through any two-speaker playback system, 

including internal television speakers. It is fully compatible with all multichannel formats.

Press the TOOLS button to display the Tools menu. You can also set the SRS TruSurround HD by selecting Tools	→	SRS	TS	
HD.
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Brightness	 :	45
Sharpness	 :	50

Auto	Adjustment	 	 ▶

Screen
Advanced	Settings
Picture	Options
Picture	Reset

Picture

Coarse	 	 	 50
Fine	 	 	 0
PC	Position
Image	Reset

U	Move					E	Enter					R	Return

Screen

Mode	 :	Custom	 ▶

Equalizer
SRS	TruSurround	HD	 :	Off
Audio	Language	 :	----
Audio	Format	 :	----
Audio	Description
Auto	Volume	 :	Off
Speaker	Select	 :	TV	Speaker

Sound
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Audio Language

You can change the default value for audio languages. Displays the language information for the incoming stream.

While viewing a digital channel, this function can be selected.

You can only select the language among the actual languages being broadcast.

Audio	Format	→	MPEG	/	Dolby	Digital
When sound is emitted from both the main speaker and the audio receiver, a sound echo may occur due to the decoding speed 

difference between the main speaker and the audio receiver. In this case, use the TV Speaker function.

While viewing a digital channel, this function can be selected.

The Audio Format appears according to the broadcasting signal.

Audio Description

This is an auxiliary audio function that provides an additional audio track for visually challenged persons. This function handles the 

Audio Stream for the AD (Audio Description), when it is sent along with the Main audio from the broadcaster. Users can turn the 

Audio Description On or Off and control the volume.

Audio	Description	→	Off	/	On
Turn the audio description function on or off.

Volume

You can adjust the audio description volume.

Volume is active when Audio Description is set to On.

While viewing a Digital channel, this function can be selected.

Auto	Volume	→	Off	/	On
Each broadcasting station has its own signal conditions, and so it is not easy to adjust the volume every time the channel is 

changed. This feature lets you automatically adjust the volume of the desired channel by lowering the sound output when the 

modulation signal is high or by raising the sound output when the modulation signal is low.

Speaker Select

When you watch TV with it connecting to a Home theatre, turn the TV speakers off so you can listen to sound from the Home 

theatre’s (external) speakers.

External Speaker: Used to listen to the sound of the External (Home Theatre) Speakers.

TV Speaker: Used to listen to the sound of the TV Speakers.

The volume and MUTE buttons do not operate when the Speaker Select is set to External Speaker.

If you select External Speaker in the Speaker Select menu, the sound settings will be limited

TV’s Internal Speakers Audio Out (Optical, L/R Out) to Sound System

RF / AV / Component / PC / HDMI RF / AV / Component / PC / HDMI

TV Speaker Speaker Output Sound Output

External Speaker Mute Sound Output

Video No Signal Mute Mute

Sound	Select	→	Main	/	Sub
When the PIP feature is activated, you can listen to the sound of the sub (PIP) picture.

You can select this option when PIP is set to On.

Press the TOOLS button to display the Tools menu. You can also set the sound of the sub picture by selecting Tools	→	PIP	
→	Sound	Select.

Sound	Reset	→	Reset	All	/	Reset	Sound	Mode	/	Cancel
You can restore the Sound settings to the factory defaults.

Reset Sound Mode: Current sound values return to default settings.
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Sound	Reset

	L	Move					E	Enter					R	Return

Cancel	sound	reset.

Reset	All Reset	Sound	Mode Cancel
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Selecting the Sound Mode

You can set the sound mode in the Tools menu. When you set to Dual l ll, the current sound mode is displayed on the screen.

Audio Type Dual 1 / 2 Default

A2 Stereo

Mono MONO
Automatic change

Stereo STEREO ↔ MONO

Dual DUAL 1 ↔ DUAL 2 DUAL 1

NICAM 
Stereo

Mono MONO
Automatic change

Stereo MONO ↔ STEREO

Dual
MONO ↔ DUAL 1 

DUAL 2
DUAL 1

If the stereo signal is weak and an automatic switching occurs, then switch to the mono.

This function is only activated in stereo sound signal. It is deactivated in mono sound signal.

This function is only available in TV mode.

¦
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SETUP

Configuring the Setup Menu

Language

You can set the menu language.

Time

For detailed procedures on setting up options, refer to the ‘Setting the Time’ instructions.

Game	Mode	→	Off	/	On 

When connecting to a game console such as PlayStation™ or Xbox™, you can enjoy a more 

realistic gaming experience by selecting game menu.

Restrictions on game mode (Caution)

To disconnect the game console and connect another external device, set Game Mode to Off in the setup menu.

If you display the TV menu in Game Mode, the screen shakes slightly.

Game Mode is not available in regular TV, PC and Ext mode.

While PIP is in operation, the Game Mode function cannot be used. 

If the picture is poor when external device is connected to TV, check if Game Mode is On. Set Game Mode to Off and 

connect external devices.

If Game Mode is On:

Picture mode is automatically changed to Standard and cannot be changed.

Sound mode is automatically changed to Custom and cannot be changed. Adjust the sound using the equalizer.

The Reset Sound function is activated. Selecting the Reset function after setting the equalizer resets the equalizer 

settings to the factory defaults.

BD	Wise	→	Off	/	On
Provides the optimal picture quality for SAMSUNG DVD, Blu-ray and Home Theatre products which support BD Wise. You can 

enjoy a richer picture when using them connected to this Samsung TV.

Connect SAMSUNG products that have BD Wise using an HDMI cable.

When the BD Wise set to On, the picture mode is automatically changed to the optimal resolution.

BD Wise is available in HDMI mode.

Network Type / Network Setup

For detailed procedures on setting up options, refer to the ‘Setting the Network’ instructions.

¦

❑

❑

❑

N
�
�

N
N
N

N
�
�
�

❑

N
N
N

❑

Plug	&	Play

Language	 :	English	 ▶

Time
Game	Mode	 :	Off
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Network	Type	 :	Cable
Network	Setup
Child	Lock	 :	On
Change	PIN

Setup
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Child	Lock	→	Off	/	On
This feature allows you to prevent unauthorized users, such as children, from watching unsuitable programme by muting out video 

and audio.

Before the setup screen appears, the PIN number input screen appears. Enter your 4 digit PIN number.

The default PIN number of a new TV set is 0-0-0-0. You can change the PIN by selecting Change PIN from the menu.

You can lock some channels in Channel List.

Child Lock is available only in TV mode.

Change PIN

You can change your personal ID number that is required to set up the TV.

Before the setup screen appears, the PIN number input screen appears. Enter your 4 digit PIN number.

The default PIN number of a new TV set is 0-0-0-0.

If you forget the PIN code, press the remote control buttons in the following sequence, which resets the PIN to 0-0-0-0: 

POWER (Off) →	MUTE	→	8	→	2	→	4	→	POWER (On).

Parental	Lock	→	Parental	Rating
This feature allows you to prevent unauthorized users, such as children, from watching unsuitable programme by a 4-digit PIN 

(Personal Identification Number) code that is defined by the user.

The Parental Rating item differs depending on the country.

Before the setup screen appears, the PIN number input screen appears. Enter your 4 digit PIN number.

The default PIN number of a new TV set is ‘0-0-0-0’. You can change the PIN by selecting Change PIN from the menu.

When the parental ratings are set, the ‘\’ symbol is displayed.

Allow All: Press to unlock all TV ratings.

Block All: Press to lock all TV ratings.

Subtitle

You can activate and deactivate the subtitles. Use this menu to set the Subtitle Mode. Normal under the menu is the basic subtitle 

and Hard of hearing is the subtitle for a hearing-impaired person.

Subtitle	→	Off	/	On
Switches subtitles on or off.

Mode	→	Normal	/	Hard	of	hearing
Sets the subtitle mode.

Subtitle Language

Set the subtitle language.

If the programme you are watching does not support the Hard of hearing function, Normal automatically activates even 

though Hard of hearing mode is selected.

English is the default in cases where the selected language is unavailable in the broadcast.

You can select these options simply by pressing the SUBT. button on the remote control.

Teletext Language

You can set the Teletext language by selecting the language type.

English is the default in cases where the selected language is unavailable in the broadcast.

Preference

Primary Audio Language / Secondary Audio Language / Primary Subtitle Language / Secondary Subtitle Language / 

Primary Teletext Language / Secondary Teletext Language

Using this feature, users can select one of the languages. The language selected here is the default when the user selects a 

channel.

If you change the language setting, the Subtitle Language, Audio Language, and the Teletext Language of the Language menu are 

automatically changed to the selected language.

The Subtitle Language, Audio Language, and the Teletext Language of the Language menu show a list of languages supported 

by the current channel and the selection is highlighted. If you change this language setting, the new selection is only valid for the 

current channel. The changed setting does not change the setting of the Primary Subtitle Language, Primary Audio Language, or 

the Primary Teletext Language of the Preference menu.
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Digital	Text	→	Disable	/	Enable
If the programme is broadcast with digital text, this feature is enabled.

MHEG (Multimedia and Hypermedia Information Coding Experts Group)

An International standard for data encoding systems used in multimedia and hypermedia. This is at a higher level than 

the MPEG system which includes data-linking hypermedia such as still images, character service, animation, graphic and 

video files as well as multimedia data. MHEG is user runtime interaction technology and is being applied to various fields 

including VOD (Video-On-Demand), ITV (Interactive TV), EC (Electronic Commerce), tele-education, tele-conferencing, 

digital libraries and network games.

Melody	→	Off	/	Low	/	Medium	/	High
A melody sound can be set to come on when the TV is powered On or Off.

The Melody does not play

When no sound is output from the TV because the MUTE button has been pressed.

When no sound is output from the TV because the volume has been reduced to minimum with the volum (-) button.

When the TV is turned off by Sleep Timer function.

Energy Saving →	Off	/	Low	/	Medium	/	High	/	Auto
This feature adjusts the brightness of the TV in order to reduce power consumption. When watching TV at night, set the Energy 

Saving mode option to High to reduce eye fatigue as well as power consumption.

Press the TOOLS button to display the Tools menu. You can also set the Energy Saving option by selecting Tools	→	
Energy Saving.

PIP

For detailed procedures on setting up options, refer to the ‘Viewing Picture-in- Picture’ instructions.

Common Interface

CI Menu

This enables the user to select from the CAM-provided menu.

Select the CI Menu based on the menu PC Card.

Application Info.

This contains information on CAM inserted in the CI slot and displays it. The Application Info inserting is about the CI CARD. 

You can install the CAM anytime whether the TV is ON or OFF.

1. Purchase the CI CAM module by visiting your nearest dealer or by phone.

2. Insert the CI CARD into the CAM in the direction of the arrow until it fits.

3. Insert the CAM with the CI CARD installed into the common interface slot. 

(Insert the CAM in the direction of the arrow, right up to the end so that it is parallel with the slot.)

4. Check if you can see a picture on a scrambled signal channel.
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Setting the Time

Clock

Setting the clock is necessary in order to use the various timer features of the TV.

The current time will appear every time you press the INFO button.

If you disconnect the power cord, you have to set the clock again.

Clock Mode

You can set up the current time manually or automatically.

Auto: Set the current time automatically using the time from the digital broadcast.

Manual: Set the current time to a manually specified time.

Depending on the broadcast station and signal, the auto time may not be set correctly. If 

this occurs, set the time manually.

The Antenna or cable must be connected in order to set the time automatically.
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Clock	 :		--	:	--	 	 ▶
Sleep	Timer	 :	Off
Timer	1	 :	Inactivated
Timer	2	 :	Inactivated
Timer	3		 :	Inactivated	 	

U	Move					E	Enter					R	Return

Time

Plug	&	Play
Language	 :	English

Time	 	 ▶

Game	Mode	 :	Off
BD	Wise	 :	On
Network	Type	 :	Cable
Network	Setup
Child	Lock	 :	On
Change	PIN
Parental	Lock

Setup
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Clock Set

You can set the current time manually.

This function is only available when Clock Mode is set to Manual.

You can set the day, month, year, hour and minute directly by pressing the number buttons on the remote control.

Sleep Timer

The sleep timer automatically shuts off the TV after a preset time (30, 60, 90, 120, 150 and 180 minutes).

Press the TOOLS button to display the Tools menu. You can also set the sleep timer by selecting Tools	→	Sleep	Timer.
To cancel the Sleep Timer function, select Off.

Timer 1 / Timer 2 / Timer 3

Three different on / off timer settings can be made.

You must set the clock first.

On Time

Set the hour, minute, and activate / inactivate.

(To activate timer with the setting you’ve chosen, set to Activate.)

Off Time

Set the hour, minute, and activate / inactivate.

(To activate timer with the setting you’ve chosen, set to Activate.)

Volume

Set the desired volume level.

Source	→	TV	/	USB	/	TV	Memory
You can select the TV, TV Memory or USB device content to be played when the TV turns on automatically. Select TV, TV 

Memory or USB. (Make sure that an USB device is connected to your TV.)

When there is only one photo file in the USB or the TV Memory, the Slide Show will not play.

Antenna (when Source is set to TV)

Select ATV or DTV.

Channel (when Source is set to TV)

Select the desired channel.

Contents (when Source is set to USB or TV Memory)

You can select a folder on the USB Device/TV Memory with music or photo files to be played when the TV turns on automatically.

If the folder name is too long, the folder can not be selected.

If you are using two of the same type USB device, be sure the folder names are different so the correct USB is read.

Repeat

Select Once, Everyday, Mon~Fri, Mon~Sat, Sat~Sun or Manual.

When Manual is selected, press the ► button to select the desired day of the week. Press the ENTERE button over the 

desired day and the c mark will appear.

You can set the hour, minute and channel by pressing the number buttons on the remote control.

Auto Power Off

When you set the timer on, the television will eventually turn off, if no controls are operated for 3 hours after the TV was turned 

on by the timer. This function is only available in timer on mode and prevents overheating, which may occur if a TV is on for 

too long time.
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Network Connection

You can set up the Internet Protocol so that you can communicate with various connected networks.

Network Connection - Cable

LAN Connection for a DHCP Environment

The procedures to set up the network using Dynamic Host Configuration Protocol (DHCP) are described below. Since an IP 

address, subnet mask, gateway, and DNS are automatically allocated when DHCP is selected, you do not have to enter them 

manually.

1. Connect the LAN port on the rear panel of the TV and the external modem with a LAN Cable.

2. Connect the Modem port on the wall and the external modem with a Modem Cable.

You can connect the LAN via a Sharer (Router).

You can connect the LAN port and the TV directly depending on your network status.

The terminals (the position of the port and the type) of the external device may differ depending on the manufacturer.

If the IP address allocation by the DHCP server has failed, turn the external modem off, turn it on again after at least 10 

seconds and then try again.

For the connections between the external modem and the Sharer (Router), refer to the owner’s manual of the corresponding 

product.

You can connect the TV to the LAN directly without connecting it through a Sharer (Router)

You cannot use a manual-connection-type ADSL modem because it does not support DHCP. You have to use an automatic-

connection-type ADSL modem.
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LAN Cable

2009-02-13    9:52:19



English - 2�

LAN Connection for Static IP Environment

The procedures to set up the network using a static IP address are described below. You have to manually enter the IP address, 

subnet mask, gateway, and DNS that are provided by your Internet Service Provider (ISP). 

1. Connect the LAN port on the rear panel of the TV and the LAN port on the wall using the LAN cable.

You can connect the LAN via a Sharer (Router).

The terminals (the position of the port and the type) of the external device may differ depending on the manufacturer.

If you are using a static IP address, your ISP will inform you of the IP address, subnet mask, gateway, and DNS. You must 

enter these values to complete the network settings. If you do not know the values, ask your network administrator.

For the information on how to configure and connect a Sharer (Router), refer to the owner’s manual for the corresponding 

product.

You can connect the TV to the LAN directly without connecting it through a Sharer (Router).

If you use an IP Sharer (IP Router) that supports DHCP, you can set up the device as either DHCP or static IP.

For the procedures to use a static IP address, ask your Internet Service Provider.

■

N
N

N

N
N
N

TV Rear PanelThe LAN Port on the Wall
IP Sharer

LAN CableLAN Cable

TV Rear PanelThe LAN Port on the Wall

1 LAN Cable

2009-02-13    9:52:19



English - 2�

Network Connection - Wireless

You can connect to the network wirelessly through a wireless IP sharer.

1. Connect the ‘Samsung Wireless LAN Adapter’ into the USB1(HDD) or USB2 terminal of the TV.

You must use the ‘Samsung Wireless LAN Adapter’(WIS09ABGN) to use a wireless network.

Samsung’s Wireless LAN adapter is sold separately. The WIS09ABGN Wireless LAN adapter is offered by select retailers, 

Ecommerce sites and Samsungparts.com.

To use a wireless network, your TV must be connected to a wireless IP sharer. If the wireless IP sharer supports DHCP, 

your TV can use a DHCP or static IP address to connect to the wireless network.

Samsung’s Wireless LAN adapter supports IEEE 802.11A, IEEE 802.11B, IEEE 802.11G, IEEE 802.11N. When you play 

DLNA video over IEEE 802.11B/G connection, the video may not be played smoothly.

If the wireless IP sharer allows you to turn the Ping connection function on/off, turn it on.

Select a channel for the wireless IP sharer that is not currently being used. If the channel set for the wireless IP sharer is 

currently being used by another device nearby, this will result in interference and communications may fail.

If you apply a security system other than the systems listed blow, it will not work with the TV. 

When applying the security key for the AP (wireless IP sharer), only the following is supported.

1) Authentication Mode : OPEN, SHARED, WPAPSK, WPA2PSK

2) Encryption Type : WEP, TKIP, AES

When applying the security key for the Ad-hoc mode, only the following is supported.

1) Authentication Mode : SHARED, WPANONE

2) Encryption Type : WEP, TKIP, AES

If your AP supports WPS(Wi-Fi Protected Setup), you can connect to the network via PBC (Push Button Configuration) or 

PIN (Personal Indentification Number). WPS will automatically configure the SSID and WPA key in either mode.

If the device isn’t certified, it may not connect to the TV via the ‘Samsung Wireless LAN Adapter’.
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Setting the Network

Network Type

Select Cable or Wireless as the method to connect to the network.

The menu is activated only if the ‘Samsung Wireless LAN Adapter’ is connected. 

Cable

Connect to the network using a cable.

Wireless

Connect to the network wirelessly.

Network Setup 

Cable Network Setup 

(when Network Type is set to Cable)

Please check if the LAN cable is connected.

Internet	Protocol	Setup	→	Auto	/	Manual
Network Test: You can test or confirm the network connection status after setting up the network.

When unable to connect to a wired network

If your Internet service provider has registered the MAC address of the device used to connect to the Internet for the first time 

and authenticates the MAC address each time you connect to the Internet, your TV may not be able to connect to the Internet 

as the MAC address differs from that of the device (PC).

In this case, ask your Internet service provider about the procedures to connect devices other than your PC (such as your TV) 

to the Internet. If your Internet service provider requires an ID or password to connect to the Internet (network), your TV may 

not be able to connect to the Internet. In this case, you have to enter your ID or password when connecting to the Internet 

using an Internet Sharer (Router).

The internet connection may fail due to a firewall problem. In this case, contact your Internet service provider. If you cannot 

connect to the Internet even if you have followed the procedures of your Internet service provider, please contact Samsung 

Electronics.

Cable Network Setup-Auto

If you connect the LAN cable and it supports DHCP, the Internet Protocol (IP) Settings are 

automatically configured. 

1. Set Network Type to Cable.

2. Select Cable Network Setup.

3. Set Internet Protocol Setup to Auto.

The Internet Protocol is set automatically.

4. Select Network Test to check the network connectivity.

Cable Network Setup-Manual 

To connect the TV to the LAN using a static IP address, you must set up the Internet Protocol 

(IP). 

1. Set Network Type to Cable.

2. Select Cable Network Setup.

3. Set Internet Protocol Setup to Manual.

4. Set up IP Address, Subnet Mask, Gateway and DNS Server.

Press the number buttons on the remote control when you set the Network manually.

�. Select Network Test to check the network connectivity.

Wireless Network Setup

The menu is activated only if the ‘Samsung Wireless LAN Adapter’ is connected.

Internet	Protocol	Setup	→	Auto	/	Manual
Network Test: You can test or confirm the network connection status after setting up the network.
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When unable to connect to an AP(Access Point)

Your TV may fail to locate an AP(Access Point) that is configured as a private SSID type. In this case, please change the AP 

settings and try again. If your Internet service provider has registered the MAC address of the device used to connect to the 

Internet for the first time and authenticates the MAC address each time you connect to the Internet, your TV may not be able 

to connect to the Internet as the MAC address differs from that of the device (PC).

In this case, ask your Internet service provider about the procedures to connect devices other than your PC (such as your TV) 

to the Internet. If you cannot connect to the Internet even if you have followed the procedures of your Internet service provider, 

please contact a Samsung Electronics.

Select a network

Access Point: You can select the IP sharer to use when using a wireless network.

If a wireless Access Point is not in the Access Point list, press the Red button.

When the connection is made, you will be returned to the screen automatically.

If you have selected an Access Point with a security authentication:

The Security Key input screen appears. Enter the security key and press the Blue button on the remote control.

If security encryption type is WEP, 0~9, A~F will be available when you input security key.

Connecting WPS (Wi-Fi Protected Setup)

If Security Key is already set: In access point list, select WPS.

You can select PBC, PIN, Security Key.

Connecting by using PBC: Select a PBC (Push Button Configuration). Press the PBC 

button on the AP (access point) within 2minutes, and wait for connection.

Try again if connecting operation doesn’t work.

Connecting by using PIN: Select a PIN (Personal Identification Number). 

The message showing the PIN Code is displayed. Input the PIN Code at AP 

device within 2minutes. Select OK and wait for connection.

Try again if connecting operation doesn’t work

Connecting by using Security Key: When selecting Security Key, the input window is 

displayed. Input the security key and press Blue button.

Try again if connecting operation doesn’t work.

If Security Key is not set: When the security setting of AP that supports WPS is NONE, 

you can select PBC, PIN, None Security. None Security is capable of connecting to AP 

directly without using WPS function.

Process of PBC, PIN is same as above. Refer to if Security Key is already set.

Try again if connecting operation doesn’t work.
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Ad-hoc: You can connect to a mobile device without an access point through the ‘Samsung Wireless LAN Adapter’ by 

using a peer to peer network.

How to connect to new Ad-hoc

1. Choose Select a network, then a device list is displayed.

2. While in the device list, press the Blue button on the remote or select Ad-

hoc.

The message The existing network system may have limited 

functionality. Do you want to change the network connection? is 

displayed.

3. Input the generated Network Name(SSID) and Security Key into the 

device you want to connect.  

N

How to connect an existing Ad-hoc device

1. Choose Select a network, the device list is displayed.

2. Select the device you want in the Device list.

3. If security key was applied, input the security key again.

If network doesn’t operate normally, please check the Network 

Name(SSID) and Security Key again. If the Security Key is incorrect, 

it may be the reason for the malfunction.

N

Wireless Network Setup-Auto

If you want to connect AP, AP should support DHCP. Only devices which support Ad-hoc mode 

can be connected without DHCP.

1. Set Network Type to Wireless.

2. Select Wireless Network Setup.

3. Set Internet Protocol Setup to Auto.

The Internet Protocol is set automatically.

4. Select a network through Select a network.

�. Select Network Test to check the network connectivity.

Wireless Network Setup-Manual

1. Set Network Type to Wireless.

2. Select Wireless Network Setup.

3. Set Internet Protocol Setup to Manual.

4. Set up IP Address, Subnet Mask, Gateway and DNS Server.

Press the number buttons on the remote control when you set the Network manually.

�. Select a network through Select a network.

�. Select Network Test to check the network connectivity.

�

N

N

Internet	Protocol	Setup	 :	Auto	 	 ▶
Network	Test
Select	a	network		 :	AP1

U	Move					E	Enter					R	Return

Wireless	Network	Setup

IP	Address	 :	 			 			 			
Subnet	Mask	 :	 			 			 			
Gateway	 :	 			 			 			 	
DNS	Server	 :	 			 			 			

Internet	Protocol	Setup	 :	Manual	 	 ▶
Network	Test
Select	a	network		 :	AP1

U	Move					E	Enter					R	Return

Wireless	Network	Setup

IP	Address	 :	 0 			 0 			 0 			 0

Subnet	Mask	 :	 0 			 0 			 0 			 0

Gateway	 :	 0 			 0 			 0 			 0 	
DNS	Server	 :	 0 			 0 			 0 			 0

The	existing	network	system	may	have	limited	
functionality.	Do	you	want	to	change	the	network	
connection?

Yes	 No	
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INPUT / SUPPORT

Input Menu

Source List

Use to select TV or other external input sources such as DVD / Blu-ray players / Cable Box /

Satellite receivers (Set-Top Box) connected to the TV. Use to select the input source of your 

choice.

Press the SOURCE button on the remote control to view an external signal source. TV 

mode can be selected by pressing the TV button, number buttons (0~9), and the P < / > 

button on the remote control.

TV / Ext.1 / Ext.2 / AV / Component / PC / HDMI1 / HDMI2 / HDMI3/DVI / HDMI4

You can choose only those external devices that are connected to the TV. In the Source 

List, connected inputs will be highlighted and sorted to the top. Inputs that are not connected 

will be sorted to the bottom.

If USB devices are connected to the USB1(HDD) and USB2 jacks, they are displayed as 

USB1 and USB2 in order.

Using the Colour buttons on the remote with the Source list

Red (Refresh): Refreshes the connected external devices. Press this if your Source is 

on and connected, but does not appear in the list.

TOOLS (Tools): Displays the Edit Name and Information menus.

Edit Name

VCR / DVD / Cable STB / Satellite STB / PVR STB / AV Receiver / Game / Camcorder / PC / DVI / DVI PC / TV / IPTV / Blu-ray 

/ HD DVD / DMA

Name the device connected to the input jacks to make your input source selection easier.

When a PC with a resolution of 1920 x 1080@60Hz is connected to the HDMI IN 3 port, you should set the HDMI3/DVI mode 

to DVI PC in the Edit Name of the Input mode.

Support Menu

Legal Notice

View the Legal Notice and General Disclaimer regarding Third Party Contents and Service.

The General Disclaimer may differ depending on the country.

Product Guide

The Product Guide gives you information on the most important features of this TV.

The descriptions provided by this function are in English only.

Picture	Quality Full HD 10�0p

100Hz Motion Plus

Picture Mode

Medi@2.0 Internet@TV

Content Library Flash

USB2.0 Movie

DLNA Wireless

Eco-Friendly Energy Saving Mode

Eco Material
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Legal	Notice	 	 ▶

Product	Guide
Self	Diagnosis
Software	Upgrade
HD	Connection	Guide
Contact	Samsung

Support

Source	List	 	

Edit	Name
Input

			Refresh					T	Tools

Source	List

TV

Ext.	1	 :	-	-	-	-
Ext.	2	 :	-	-	-	-
PC	 :	-	-	-	-

AV	 :	-	-	-	-
Component	 :	-	-	-	-
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Using the Remote Control Buttons in the Product Guide Menu

Button Operations

Yellow Button Shows the contents of the Product Guide sequentially. (Auto Play)

◄/► Move the cursor and select an item.

ENTERE Select the currently selected item.

RETURN Return to the previous menu.

EXIT Stop the current function and return to the Product Guide main menu.

Self Diagnosis

Picture Test

If you think you have a picture problem, perform the picture test. Check the colour pattern on 

the screen to see if the problem still exists.

Yes: If the test pattern does not appear or there is noise in the test pattern, select Yes. 

There may be a problem with the TV. Therefore, contact Samsung’s call centre for 

assistance.

No: If the test pattern is properly displayed, select No. There may be a problem with your external equipment. Please check 

your connections. If the problem still persists, refer to the external device’s user manual.

Sound Test

If you think you have a sound problem, please perform the sound test. You can check the sound by playing a built-in melody sound 

through the TV.

If you hear no sound from the TV’s speakers, before performing the sound test, make sure Speaker Select is set to TV 

speaker in the Sound menu.

The melody will be heard during the test even if Speaker Select is set to External Speaker or the sound is muted by pressing 

the MUTE button.

Yes: If during the sound test you can hear sound only from one speaker or not at all, select Yes. There may be a problem with 

the TV. Therefore, contact Samsung’s call centre for assistance.

No: If you can hear sound from the speakers, select No. There may be a problem with your external equipment. Please check 

your connections. If the problem still persists, refer to the external device’s user manual.

Signal Information (digital channels only)

Unlike analogue channels, which can vary in reception quality from ‘snowy’ to clear, digital (HDTV) channels have either perfect 

reception quality or you will not receive them at all. So, unlike analogue channels, you cannot fine tune a digital channel. You can, 

however, adjust your antenna to improve the reception of available digital channels.

If the signal strength meter indicates that the signal is weak, physically adjust your antenna to increase the signal strength. 

Continue to adjust the antenna until you find the best position with the strongest signal.

Software Upgrade

Samsung may offer upgrades for the TV’s firmware in the future. These upgrades can be 

performed via the TV when it is connected to the Internet, or by downloading the new firmware 

from samsung.com to a USB memory device.

Current Version is the software already installed in the TV.

Alternative Software (Backup) shows the previous version that will be replaced.

Software is represented as ‘Year/Month/Day_Version’. The more recent the date, the newer 

the software version. Installing the latest version is recommended.

By USB

Insert a USB drive containing the firmware upgrade downloaded from samsung.com into the 

TV. Please be careful to not disconnect the power or remove the USB drive while upgrades 

are being applied. The TV will turn off and turn on automatically after completing the firmware 

upgrade. Please check the firmware version after the upgrades are complete (the new version 

will have a higher number than the older version).

When software is upgraded, video and audio settings you have made will return to their default 

(factory) settings. We recommend you write down your settings so that you can easily reset 

them after the upgrade.

By Channel

Upgrades the software using the broadcasting signal.
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or

USB Drive

Self	Diagnosis

U	Move						E	Enter					R	Return

Picture	Test	 	 	 ▶
Sound	Test
Signal	Information

Current	Version	 2008/11/17_000001

By	USB	 	 	 ▶
By	Channel
Standby	Mode	Upgrade	 :	45	Min	
Alternative	Software	 2008/11/16_000000

U	Move					E	Enter					R	Return

Software	Upgrade
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Standby Mode Upgrade

To continue software upgrade with master power on, Select On by pressing the ▲ or ▼ button. 45 minutes after entering standby 
mode, a manual upgrade is automatically conducted. Since the power of the unit is turned on internally, the screen may be on 

slightly for the LCD product. This phenomenon may continue for more than 1 hour until the software upgrade is completed.

Alternative Software (Backup)

If there is an issue with the new firmware and it is affecting operation, you can change the software to the previous version.

If software was changed, existing software is displayed.

You can change current software to alternative software by ‘Alternative Software’.

HD Connection Guide

This menu presents the connection method that provides the optimal quality for the HD TV. Refer to this information when 

connecting external devices to the TV.

Contact Samsung

View this information when your TV does not work properly or when you want to upgrade the software. You can view the 

information regarding the call centre, product and software file download method.

■

■

N
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❑
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MEDIA PLAY (USB & DLNA)

Connecting a USB Device

1. Press the POWER button to turn the TV on.

2. Connect a USB device containing photo, music and/or movie files to the USB1(HDD) or USB2 

jack on the side of the TV.

3. When the Application selection screen is displayed, press the ENTERE button to select 

Media Play (USB & DLNA).

MTP (Media Transfer Protocol) is not supported.

The file system supports FAT16, FAT32 and NTFS.

Certain types of USB Digital camera and audio devices may not be compatible with this 

TV.

Media Play only supports USB Mass Storage Class devices (MSC). MSC 

is a Mass Storage Class Bulk-Only Transport device. Examples of MSC 

are Thumb drives, Flash Card Readers and USB HDD (USB HUB are not 

supported.). 

Please connect directly to the USB port of your TV. If you are using a separate 

cable connection, there may be a USB compatibility problem.

Before connecting your device to the TV, please back up your files to prevent 

them from damage or loss of data. SAMSUNG is not responsible for any data 

file damage or data loss.

Connect a USB HDD to the dedicated port, USB1 (HDD) port. However, if the connected device requires high power, the 

USB1 (HDD) may fail to support the device.

Do not disconnect the USB device while it is loading.

MSC supports MP3 and JPEG files, while a PTP device supports JPEG files only.

The higher the resolution of the image, the longer it takes to display on the screen.

The maximum supported JPEG resolution is 15360X8640 pixels.

For unsupported or corrupted files, the ‘Not Supported File Format’ message is displayed.

If sort key is set to Basic View, up to 1000 files can be displayed in each folder. The other sort key can display up to 10000 

files.

MP3 files with DRM that have been downloaded from a non-free site cannot be played. Digital Rights Management (DRM) 

is a technology that supports the creation of content, the distribution and management of the content in an integrated 

and comprehensive way, including the protection of the rights and interests of the content providers, the prevention of the 

illegal copying of contents, as well as managing billings and settlements.

When moving to a photo, loading may take a few seconds. At this point, the loading icon will appear at the screen. 

If more than 2 PTP devices are connected, you can only use one at a time. 

If more than one MSC device is connected, some of them may not be recognized. If a device requires high power (more 

than 500mA or 5V), the USB device may not be supported. 

If an over-power (Fail add new device USB1/USB2 Power Overload) warning message is displayed while you are 

connecting or using a USB device, the device may not be recognized or may malfunction.

Using the Remote Control Button in Media Play Menu

Button Operations

▲/▼/◄/► Move the cursor and select an item.

ENTERE
Select the currently selected item. While playing a slide show, movie, or music file:

- Pressing the ENTERE button during play pauses the play.

- Pressing the ENTERE button during pause resumes the play.

∂/∑ Play or pause the Slide Show, music or movie.

RETURN Return to the previous menu.

TOOLS Run various functions from the Photo, Music and Movie menus.

∫ Stop the current slide show, Music or Movie file.

π/μ Jump to previous group/Jump to next group.

INFO Show file information.

MEDIA.P Exit Media Play mode.

< P >, EXIT, TV Stop Media Play mode and Returns to TV mode.
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Media Play Function

This function enables you to view and listen to photo, music and/or movie files saved on a USB Mass Storage Class (MSC) device.

Entering the Media Play (USB & DLNA) Menu

1. Press the MENU button. Press the ▲ or ▼ button to select Application, then 

press the ENTERE button.

2. Press the ▲ or ▼ button to select Media Play (USB & DLNA), then press the 

ENTERE button.

The Media Play (USB & DLNA) menu is displayed.

Press the MEDIA.P button on the remote control to display the Media Play 

menu.

Press the SOURCE button on the remote control to view the source list. 

Then Press the ▲ or ▼ button to select USB.

3. Press the Red button, then press the ▲ or ▼ button to select the TV memory or 
USB Memory. Press the ENTERE button.

This function differs depending on the TV Memory / USB Memory Device / 

DLNA device.

The selected USB device name appears at the bottom left of the screen.

4. Press the ◄ or ► button to select an icon (Photo, Music, Movie, Setup), then 

press the ENTERE button. 

To exit Media Play mode, press the MEDIA.P button on the remote control.

Removing a USB Memory Device Safely

You can remove the device safely from the TV.

1. Press the TOOLS button in the Media Play file list screen, or while a Slide Show, music or movie is being played.

2. Press the ▲ or ▼ button to select Remove Safely, then press the ENTERE button.

3. Remove the USB device from the TV.

Screen Display

Move to either ‘Sort key List Section’, ‘Group List Section’ or ‘File List Section’ using the Up and Down buttons. After selecting a 

section, press the ◄ or ► buttons to select an item.
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1 Current Sort key: This field shows the current standard for sorting files. Press the ◄ or ► button to change the standard for 
sorting files.

2 View Groups: Shows the detailed groups of the files sorted according the selected Sort key. The sort group where the 

currently selected file is contained is highlighted.

3 Currently selected file: The selected file is the file you can now control. Photo and movie files are displayed as thumbnail 

images.

4 Current Device: Shows the currently selected device name. Press the Red button to select a device.

Red (Device) button: Selects a connected device.

5 Item Selection Information: Shows the number of files that are selected by pressing the Yellow button.

6 Help Items

Green (Favourites Settings) button: Changes the Favourites Settings for the selected file. Press this button repeatedly 

until the desired value appears.

Yellow (Select) button: Selects file from the file list. Selected files are marked with a symbol c. Press the Yellow button 

again to cancel a file selection.

TOOLS (Tools) button: Displays the option menus. (The option menu changes according to the current status.)

Sorting the Photo List

You can sort photos in the Photo List by a particular standard.

1. Press the MEDIA.P button.

2. Press the ◄ or ► button to select Photo, then press the ENTERE button. 

3. Press the ▲ button to move to the Sort key Section.
4. Press the ◄ or ► button to select a sorting standard. (Basic View, Timeline, 

Colour, Folder, Preference)

The photos are sorted according to the newly selected sorting standard.

�.  Press the ▼ button to move to the File List Section. Press the ∂ (Play)/

ENTERE button to start the Slide Show in the order you selected.

To move to the previous/next group, press the π (REW) or μ (FF) button.

Photo information is automatically set. The colour information extracted from a photo file may be different from your 

expectations. You can change the colour and preference.

PTP does not support folder sort mode.

Basic View

Shows the folders on the USB memory device. If you select a folder and press the ENTERE button, only the photo files 

contained in the selected folder are displayed.

When sorted according to the Basic View, you cannot set Favourites files.

Timeline

Sorts photos by date. It sorts by year and month from the earliest photo.

Colour	→	Red	/	Yellow	/	Green	/	Blue	/	Magenta	/	Black	/	Gray	/	Unclassified
Sorts photos by colour. You can change the photo colour information.

You should set the Use Colour View to on in the Setup menu before sorting photos by colour.

Folder

Sorts photos by folder. If there are many folders in USB, the photos files are shown in order in each folder. The photo file in the 

Root folder is shown first and the others are shown in alphabetical order by name.

Preference	→	FFF / FFF / FFF / FFF
Sorts photos by preference (Favourites). You can change the photo preferences.

Changing the Favourites Settings

Select the desired photo in the Photo list, then press the Green button repeatedly until the desired setting appears.

Up to 3 stars can be selected.

The stars are for grouping purposes only. For example, the 3 star setting does not have any priority over the one star setting.
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Photo List Option Menu

1. Press the MEDIA.P button.

2. Press the ◄ or ► button to select Photo, then press the ENTERE button. 

3. Press the ▼ button to move to the File List Section.
4. Press the ◄ or ► button to select the desired photo file.

Selecting Multiple Photos

Press the ◄ or ► button to select the desired photo file. Then press the Yellow button.
Repeat the above operation to select multiple photo files.

The mark c appears to the selected photo file.

�. Press the TOOLS button.

The option menu changes according to the current status.

Slide Show

Using this menu, you can play a SlideShow using the photo files on the USB memory 

device.

Copy / Copy Current Group / Copy the selected file (When multiple files 
are selected)

Select a photo you want to copy. (Alternatively, select multiple files by pressing the 

Yellow button.) Press the TOOLS button to select Copy (or Copy Current Group / 

Copy the selected file). The files on the USB device are saved to the TV memory.

You can only copy the files saved on the USB device. 

When the TV memory is full, files cannot be copied.

Delete / Delete All / Delete Selected File (When multiple files are selected)

Select a photo to delete. (Alternatively, select multiple files by pressing the Yellow button.) Press the TOOLS button to select 

Delete (or Delete All / Delete Selected File). The files are deleted. 

You can only delete the files saved in the TV memory.

You cannot recover a deleted file. 

Play Current Group

Using this menu, you can play a SlideShow using only the photo files in the currently selected sorting group.

Change Group (When the Sort key is the Colour)

You can change a selected photo file’s (or group of files) colour information in order to move it from one colour group to another.

This does not change the actual colour of the photo.

The group information of the current file is updated and the photos are moved to the new colour group.

To change the information of multiple files, select the files you want by pressing the Yellow button.

Deselect All (When at least one file is selected)

You can deselect all files.

The c mark indicating the corresponding file is selected is hidden.

Information

The photo file information including the name, the size, the resolution, the date modified and the path is displayed.

You can view the information of photo files during a SlideShow using the same procedures.

Press the INFO button to viewing the information. 

Remove Safely

You can remove the device safely from the TV.
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Viewing a Photo or Slide Show

Viewing a Slide Show

1. Press the ▼ button to select the File List Section.
2. Press the TOOLS button.

3. Press the ▲ or ▼ button to select Slide Show, then press the ENTERE button.

All files in the photo list will be used for the Slide Show.

During the slide show, files are displayed in order from the currently shown file.

The Slide Show progresses in the order sorted in the Photo list.

Music files can be automatically played during the Slide Show if the Background 

Music is set to On. 

While a photo list is displayed, press the ∂(Play)/ENTERE button on the 

remote control to start slide show.

SlideShow Control Buttons

Button Operations

ENTERE Play/Pause the Slide Show.

∂ Play the Slide Show.

∑ Pause the Slide Show.

∫ Exit Slide Show and return to the photo list.

π/μ Change the SlideShow playing speed.

TOOLS Run various functions from the Photo menus.

Playing current group

1. Press the ▲ button to move to the Sort key Section.
2. Press the ◄ or ► button to select a sorting standard. 
3. Press the ▼ button to move to the Group List Section.
4. Select a group using the ◄ and ► buttons.
�. Press the ∂ (Play) button. A slideshow begins with the files of the selected 

group.

Alternatively 

1. Select a Sort key and then in the File List Section, select the photos contained in 

the desired group.

To move to the previous/next group, press the π (REW) or μ (FF) button.

2. Press the TOOLS button. 

3. Press the ▲ or ▼ button to select Play Current Group, then press the ENTERE button.

Only the photos in the sorting group including the selected files will be used for the Slide Show.

To	perform	a	Slide	Show	with	only	the	selected	fi	les
1. Press the ▼ button to select the File List Section.
2. Press the ◄ or ► button to select the desired photo in the Photo list.
3. Press the Yellow button.

4. Repeat the above operation to select multiple photos.

The c mark appears to the left of the selected photo.

If you select one file, the Slide Show will not be performed.

To deselect all selected files, press the TOOLS button and select Deselect All.
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�. Press the ∂ (Play)/ENTERE button.

The selected files will be used for the Slide Show.

Alternatively 

1. In the Photo List, press the Yellow buttons to select the desired photos.

2. Press the TOOLS button. 

3. Press the ▲ or ▼ button to select Slide Show, then press the ENTERE button.

The selected files will be used for the Slide Show.

Slide Show Option Menu

1. During a slide show (or when viewing a photo), press the TOOLS button to set the option.

2. Press the ▲ or ▼ button to select the desired option, then press the ENTERE button.

Stop Slide Show / Start Slide Show

You can start or stop a SlideShow.

Slide	Show	Speed	→	Slow	/	Normal	/	Fast
You can select the slide show speed.

This function is available only during a slide show.

You can also change the speed of the Slide Show by pressing the π (REW) or 

μ (FF) button during the Slide Show.

Slide Show Effect 

You can select the screen transition effect used in the slideshow.

None / Fade1 / Fade2 / Blind / Spiral / Checker / Linear / Stairs / Wipe / Random

This function is available only during a slide show.

Rotate

You can rotate photos saved on a USB memory device.

Whenever you press the ◄ button, it rotates by 270˚, 180˚, 90˚, and 0˚.
Whenever you press the ► button, it rotates by 90˚, 180˚, 270˚, and 0˚. 
The rotated file is not saved.

Zoom

You can magnify photos saved on a USB memory device. (x1 → x2 → x4)
To move the enlarged photo image, press the ENTERE button, then press the ▲/▼/◄/► buttons. Note that when the 
enlarged picture is smaller than the original screen size, the location change function doesn’t work.

The enlarged file is not saved.

Background Music

You can select background music when watching a Slide Show.

To use this feature, there must be music and photo files stored on the USB device.

Loading music files is needed to change BGM mode. Play music files in music category to load.

Background	Music	→	Off	/	On	
Off: Background music is not played.

On: When the background music is available, if you select On, the music is played back. 

BGM	Mode	→	Mood	/	Selected	File	/	Shuffle
You can select a mode to use for the background music.

BGM	Mood	→	Energetic	/	Rhythmical	/	Sad	/	Exciting	/	Calm	/	Unclassified
Music with the mood you selected is set as the background music.

If you set BGM Mode to Mood, you can select a mood.

Select Music File (0 File(s) Selected)

Only the selected music file is set as the background music.

If you set BGM Mode to Selected File, you can select a music file.
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Sorting the Music List

You can sort music files in the Music List by a particular standard.

1. Press the MEDIA.P button.

2. Press the ◄ or ► button to select Music, then press the ENTERE button.

3. Press the ▲ button to move to the Sort key Section. 
4. Press the ◄ or ► button to select a sorting standard. (Basic View, Title, Artist, 

Mood, Genre, Folder, Preference)

The Music files are sorted according to the newly selected sorting standard.  

�. Press the ▼ button to move to the File List Section. Press the ENTERE button to 

start playing music in the order selected by the user.

To move to the previous/next group, press the π (REW) or μ (FF) button.

Music information is automatically set. The mood information extracted from 

a music file may differ from the expectations of the user. You can change the 

mood and preference.

If there is no title information for a music file, the filename is displayed.

If no information is available for the Artist, Album, Year, or Genre the corresponding item is displayed as blank.

Basic View

Shows the folders of the USB memory device. If you select a folder and press the ENTERE button, only the music files 

contained in the selected folder are displayed.

When sorted according to the Basic View, you cannot set Favourites files.

Title

Sorts the music titles in symbol/number/alphabet/special order, and shows the music file.

Artist

Sorts the music file by artist in symbol/number/alphabet/special order.

Mood	→	Energetic	/	Rhythmical	/	Sad	/	Exciting	/	Calm	/	Unclassified	
Sorts music files by the mood. You can change the music mood information.

Genre

Sorts music files by the genre.

Folder

Sorts music files by the folder. If there are many folders in USB, the files are shown in order in each folder. The music file in the 

Root folder is shown first and the others are shown in alphabetical order by name.

Preference	→	FFF / FFF / FFF / FFF
Sorts music files by preference (Favourites). You can change the music files preferences.

Changing the Favourites Settings

Select the desired music file in the Music list, then press the Green button repeatedly until the desired setting appears. 

Up to 3 stars can be selected.

The stars are for grouping purposes only. For example, the 3 star setting does not have any priority over the one star setting.
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Picture Setting / Sound Setting

You can select the picture and sound settings.

Information

The photo file information is displayed.

Remove Safely

You can remove the device safely from the TV.
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Music List Option Menu

1. Press the MEDIA.P button.

2. Press the ◄ or ► button to select Music, then press the ENTERE button. 

3. Press the ▲ button to move to the File List Section.
4. Press the ◄ or ► button to select the desired Music file. 

Selecting Multiple Music Files

Press the◄ or ► button to select the desired music file. Then press the 
Yellow button.

Repeat the above operation to select multiple music files.

The mark c appears to the selected music file.

�.  Press the TOOLS button.

The option menu changes according to the current status.

Play Current Group

Using this menu, you can only play music files in the currently selected sorting group.

Copy / Copy Current Group / Copy the selected file (When multiple files are selected)

Select the music to copy. (Alternatively, select multiple files by pressing the Yellow button.) Press the TOOLS button to select Copy 

(or Copy Current Group / Copy the selected file). The files on the USB device are saved to the TV memory.

You can only copy the files saved on the USB device. 

When the TV memory is full, files cannot be copied.

Delete / Delete All / Delete Selected File (When multiple files are selected)

Select the file to delete. (Alternatively, select multiple files by pressing the Yellow button.) Press the TOOLS button to select Delete 

(or Delete All / Delete Selected File). 

The files are deleted. 

You can only delete the files saved in the TV memory.

You cannot recover a deleted file. 

Change Group (When the Sort key is Mood)

You can change the mood information of music files.

The group information of the current file is updated and the file is moved to the new group.

To change the information of multiple files, select files by pressing the Yellow button.

Deselect All (When at least one file is selected)

You can deselect all files.

The c mark indicating the corresponding file is selected is hidden.

Information

The music file information including the name, the size, the date modified and the path is displayed.

You can view the music file information during Play Current Group using the 

same procedures.

Press the INFO button to viewing the information. 

Remove Safely

You can remove the device safely from the TV.
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Playing a Music

Playing	a	music	file
1. Press the ▼ button to select the File List Section.
2. Press the ◄ or ► button to select a music file to be played.
3. Press the ∂ (Play)/ENTERE button.

This menu only shows files with the MP3 file extension. Files with other 

file extensions are not displayed, even if they are saved on the same USB 

device.

The selected file is displayed at the top with its playing time.

To adjust the music volume, press the volume button on the remote control. 

To mute the sound, press the MUTE button on the remote control.

If the sound is odd when playing MP3 files, adjust the Equalizer and SRS TruSurround HD in the Sound menu. (An 

over-modulated MP3 file may cause a sound problem.)

The playing duration of a music file may be displayed as ‘00:00:00’ if its playing time information is not found at the start of 

the file.

π (REW) or μ (FF) buttons do not function during play.

Music Play Control Buttons

Button Operations

ENTERE Play/Pause the music file.

∂ Play the music file

∑ Pause the music file

∫ Exit play mode and return to the music list.

TOOLS Run various functions from the Music menus.

Music function information icon

p When all music files in the folder (or the selected file) are repeated. Repeat Mode is On.

q When all music files in the folder (or the selected file) are played once. Repeat Mode is Off.

Playing the music group

1. Press the ▲ button to move to the Sort key Section.
2. Press the ◄ or ► button to select a sorting standard.
3. Press the ▼ or ENTERE button to move to the Group List Section.

4. Press the ∂ (Play) button. The files of the selected group will start playing.

Alternatively 

1. Select a sort key and then in the File List Section, select the files contained in the desired group.

To move to the previous/next group, press the π (REW) or μ (FF) button.

2. Press the TOOLS button. 

3. Press the ▲ or ▼ button to select Play Current Group, then press the ENTERE button.

The music files in the sorting group including the selected file are played.

Playing	the	selected	music	files
1. Press the ▼ button to select the File List Section.
2. Press the ◄ or ► button to select the desired music file.
3. Repeat the above operation to select multiple music files.

The c appears to the left of the selected music file.

To deselect all selected files, press the TOOLS button and select Deselect All.

4. Press the ∂ (Play)/ENTERE button.

The selected files will be played.
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Music Play option Menu

Music Play Option Menu

Repeat	Mode	→	On	/	Off
You can play music files repeatedly.

Picture Setting / Sound Setting

You can configure the picture and sound settings.

Information

The music file information is displayed.

Remove Safely

You can remove the device safely from the TV.

¦

❑

❑

❑

❑

Sorting the Movie List

You can sort movies in the Movie List by a particular standard.

1. Press the MEDIA.P button.

2. Press the ◄ or ► button to select Movie, then press the ENTERE button.

3. Press the ▲ button to move to the Sort key Section.
4. Press the ◄ or ► button to select a sorting standard. (Basic View, Timeline, 

Title, Folder, Preference)

The movie files are sorted according to the newly selected sorting standard.  

�. Press the ∂ (Play)/ENTERE button to play the movie in the order selected.

Movie information is automatically set. You can change the preference.

Basic View

Shows the folders of the USB memory device. If you select a folder and press the ENTERE button, only the movie files 

contained in the selected folder are displayed.

When sorted according to the Basic View, you cannot set Favourites files.

Timeline

Sorts movies by date. It sorts by year and month from the earliest movie.

Title

Sorts and displays the movie titles in symbol/number/alphabet/special order.

Folder

If there are many folders in USB, the movies files are shown in order in each folder. The movie file in the Root folder is shown first 

and the others are shown in alphabetical order by name.

Preference	→	FFF / FFF / FFF / FFF
Sorts movies by preference. (Favourites) You can change the movie preferences.

Changing the Favourites Settings

Select the desired movie file in the movie list, then press the Green button repeatedly until the desired setting appears.

Up to 3 stars can be selected.

The stars are for grouping purposes only. For example, the 3 star setting does not have any priority over the one star setting.
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Movie List Option Menu

1. Press the MEDIA.P button.

2. Press the ◄ or ► button to select Movie, then press the ENTERE button. 

3. Press the ▲ button to move to the File List Section.
4. Press the ◄ or ► button to select the desired Movie file. 

Selecting Multiple Movie Files

Press the◄ or ► button to select the desired movie file. Then press the 
Yellow button.

Repeat the above operation to select multiple movie files.

The mark c appears to the selected movie file.

�.  Press the TOOLS button.

The option menu changes according to the current status.

Play Current Group

Using this menu, you can only play movie files in the currently selected sorting group.

Copy / Copy Current Group / Copy the selected file (When multiple files are selected)

Select the movie to copy. (Alternatively, select multiple files by pressing the Yellow button.) Press the TOOLS button to select 

Copy (or Copy Current Group / Copy the selected file). The files on the USB device are saved to the TV memory.

You can only copy the files saved on the USB device. 

When the TV memory is full, files cannot be copied.

Delete / Delete All / Delete Selected File (When multiple files are selected)

Select the file to delete. (Alternatively, select multiple files by pressing the Yellow button.) Press the TOOLS button to select 

Delete (or Delete All / Delete Selected File). The files are deleted. 

You can only delete the files saved in the TV memory.

You cannot recover a deleted file. 

Deselect All (When at least one file is selected)

You can deselect all files.

The c mark indicating the corresponding file is selected is hidden.

Information

The movie file information including the name, the size, the date modified and the path is displayed.

Press the INFO button to viewing the information. 

Remove Safely

You can remove the device safely from the TV.

Playing a Movie File

Playing	a	movie	file
1. Press the ▼ button to select the File List Section. 
2. Pressing the ◄ or ► button to select a movie file to be played.
3. Press the ∂ (Play)/ENTERE button.

The selected file is played.

The selected file is displayed at the top with its playing time.

The playing duration of a movie file may be displayed as ‘00:00:00’ if its 

playing time information is not found at the start of the file.

You can watch exciting gaming multimedia files, but the gaming function is not 

supported.
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Supported Subtitle Formats

Name File extention Format

MPEG-4 time-based text .ttxt XML

SAMI .smi HTML

SubRip .srt string-based

SubViewer .sub string-based

Micro DVD .sub or .txt string-based

Supported Video Formats  

File Extention Container Video Decoder Audio codec

*.avi AVI

Divx 3.11

MP3, AC3, LPCM, ADPCM (MULAW 
ALAW)

Divx 4.x

Divx 5.1

Divx 6.0

XviD

H.264 BP

H.264 MP

H.264 HP

MPEG-4 SP

MPEG-4 ASP

Motion JPEG

*.mkv MKV

Divx 3.11

MP3, AC3, LPCM, ADPCM (MULAW 
ALAW), AAC

Divx 4.x

Divx 5.1

Divx 6.0

XviD

H.264 BP

H.264 MP

H.264 HP

MPEG-4 SP

MPEG-4 ASP

Motion JPEG

*.asf
ASF

Divx 3.11

WMA, MP3, AC3, LPCM, ADPCM, 
(MULAW ALAW), AAC

Divx 4.x

Divx 5.1

Divx 6.0

XviD

H.264 BP

H.264 MP

H.264 HP

MPEG-4 SP

MPEG-4 ASP

*.wmv (VC1) Window Media Video v9

*.mp4 MP4 (SMP4)

H.264 BP

ADPCM, (HE)-AAC, mp3

H.264 MP

H.264 HP

MPEG-4 SP

MPEG-4 ASP

XVID

*.3gp 3GPP

H.264 BP

ADPCM, (HE)-AAC

H.264 MP

H.264 HP

MPEG-4 SP

MPEG-4 ASP

*.vro (ps) VRO / VOB
MPEG2

AC3, MPEG, LPCM
MPEG1

*.mpg
*.mpeg (ps)

MPEG1 (Program Stream)
AC3, MPEG, LPCM

MPEG2 (Program Stream)

others (ts)

MPEG2 (Transport Stream)

AAC, HE-AAC, MP3, DD+H.264 (Transport Stream)

VC1 (Transport Stream)
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Video Play Control Buttons

Button Operations

ENTERE Play/Pause the movie file

∂ Play the movie file

∑ Pause the movie file

TOOLS Run various functions from the Movie menus.

∫ Exit play mode and return to the movie list.

◄ / ► Skip forwards or backwards through the movie file.

▲ / ▼ Move to the first/last of the file.

μ Play the file at double speed. This function may not be supported depending on the codec.

Playing the movie group

1. Press the ▲ button to move to the Sort key Section.
2. Press the ◄ or ► button to select a sorting standard. 
3. Press the ▼ or ENTERE button to move to the Group List Section.

4. Press the ∂ (Play) button. Only the files of the selected group will start playing.

Alternatively 

1. Select a Sort key and then in the File List Section, select the files contained in the desired group.

To move to the previous/next group, press the π (REW) or μ (FF) button.

2. Press the TOOLS button. 

3. Press the ▲ or ▼ button to select Play Current Group, then press the ENTERE button.

The movie files in the sorting group including the selected file are played.

Playing	the	selected	movie	files
1. Press the ▼ button to select the File List Section.
2. Press the ◄ or ► button to select the desired movie file.
3. Press the Yellow button. 

The c mark appears to the left of the selected movie file.

4. Repeat the above operation to select multiple movie files.

�. Press the ∂ (Play)/ENTERE button.

Only the selected file is played.

Playing movie continuously (Resume Play)

If you exit the playing movie function, the movie can be played later from the point where it was stopped.

1. Select the movie file you want to play continuously by pressing the ◄ or ► button to select it from the Movie List.
2. Press the ∂ (Play)/ENTERE button.

3. Select Cont. Movie Play Help (Resume Play) by pressing the Blue button.

The Movie will begin to play from where it was stopped.

If Cont. Movie Play Help function is set On in the Setup menu, a pop-up message will appear when you resume play a 

movie file.

Movie Play Option Menu

Movie Play Option Menu

Picture Setting / Sound Setting

You can configure the picture and sound settings.

Picture Size

Fit

Play video at the TV screen size.

Original

Play video at the original size.
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Caption Setting

You can set the captions for the movie.

Caption	→	On	/	Off
You can turn the captions for the movie on or off.

Caption Language

You can set the caption language.

Caption	Size	→	Small	/	Standard	/	Large
You can change the font size of the captions.

Caption Sync

You can adjust the caption sync.

Caption Sync Reset

You can reset the adjusted caption sync.

Information

The movie file information is displayed.

Remove Safely

You can remove the device safely from the TV.
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Using the Setup Menu

Setup displays the user settings of the Media Play menu.

1. Press the MEDIA.P button.

2. Press the ◄ or ► button to select Setup, then press the ENTERE button.

3. Press the ▲ or ▼ button to select the desired option.
4. Press the ◄ or ► button to select the option, then press the ENTERE button.

To exit Media Play mode, press the MEDIA.P button on the remote control.

Use	Colour	View	→	On	/	Off
You can select sorting photos by colour. If this option is set to On, the loading time may 

be increased to collect colour information from the photos.

Music	Repeat	Mode	→	On	/	Off
Select to repeatedly play music files.

Cont.	movie	play	help	→	On	/	Off
Select to display the help pop-up message for continuous movie playback.

Get DivX® VOD registration code

Shows the registration code authorized for the TV. If you connect to the DivX web site 

and register the registration code with a personal account, you can download VOD 

registration file.

If you play the VOD registration using Media Play, the registration is completed.

For more information on DivX® VOD, visit www.DivX.com.

Get DivX® VOD deactivation code

When DivX® VOD is not registered, the registration deactivation code is displayed.

If you execute this function when DivX® VOD is registered, the current DivX® VOD registration is deactivated.

Screen	Saver	Run	Time	→	2	hours	/	4	hours	/	8	hours
Select to set the waiting time before the screen saver appears.

Information

Select to viewing the information of the connected device.

Remove Safely

You can remove the device safely from the TV.
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MEDIA PLAY-DLNA

Setting the DLNA Network

DLNA allows you to watch pictures, musics and videos saved on your PC or on your TV through a network connection in Media 

Play mode. This removes the need to copy them to a USB storage device and then connect the device to your TV. To use DLNA, 

the TV must be connected to the network and the DLNA application must be installed on your PC.

Network Connection Diagram-Cable

Network Connection Diagram-Wireless

1. For more information on how to configure your network, refer to ‘Setting the Network’.

You are recommended to locate both TV and PC in same subnet. The first 3 parts of the subnet address of the TV and 

the PC IP addresses should be the same and only the last part (the host address) should be changed. (e.g. IP Address: 

123.456.789.**)

2. Connect the PC to which the Samsung PC Share Manager program will be installed and the external modem using a LAN 

cable.

You can connect the TV to the PC directly without connecting it through a Sharer (Router).

¦
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Installing the DLNA Application

To play content on the PC on the TV, you have to first install the application. To use the DLNA function smoothly, use the 

program in the CD-ROM supplied with the TV or use the Samsung PC Share Manager program corresponding to the TV 

model that can be downloaded from the Samsung web site.

System Requirements

1. Insert the Programme CD supplied with this TV into your PC.

2. 30MB of free hard disk space is needed for the programme installation.

If you share files, up to 30MB of hard disk drive space is required for each 100 files.

If you cancel file sharing, the hard disk drive space used for the thumbnail information is also freed.

Supported Formats

Image: JPEG/ Audio: MP3/ Video: AVI, MKV, ASF, MP4, 3GPP, PS, TS container. For detailed supported video formats, refer 

to the ‘Playing a Movie File’ instructions.

Install the application

 



1. Run the Setup.exe file on the Programme CD supplied with the product.

Alternatively, you can download the file from www.samsung.com.

2. Install the SAMSUNG PC Share Manager as shown in the figures.

3. When the installation is complete, the PC Share Manager icon appears on your Desktop.

Double-click the icon to run the programme.

¦
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Using the DLNA Application

The Programme Screen Layout

1

3 4 5
6 7

2

1. Menus: The following application menus are provided : File, Share, Server, and Help.

2. Click to share the selected PC server folder.

3. Click to cancel sharing.

4. Click to refresh the PC folder and files.

�. Click to synchronize the share status.

�. The folders and files of the PC to be shared are listed.

�. Folders shared by the user are listed.

File

Property

Shows information on the selected file or folder.

Method 1: Select a file or folder and select the File menu and then select the Property sub-menu.

Method 2: Select a file or folder, right-click over the selected file or folder and then select Property from the pop-up menu.

<Method 1> <Method 2>

 

Exit

Exits the DLNA application.

If you select Exit without applying the changes after changing the shared status, a message will appear asking if you want to apply 

the changed settings to the PC. Select Yes to apply the changes and exit the application.

¦
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■
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Share

Sharing a Folder

You can share a folder from your PC to the TV. The maximum number of folders that can be shared is 32.

Your PC will operate as a server to the TV.

Method 1: Select a folder in My Computer, select the Share menu and then select the Share Folder sub-menu.

Method 2: Select a folder in My Computer, right-click over the selected folder and then select Share Folder from the popup 

menu.

Method 3: Locate the mouse pointer over a folder in the My Computer folder list in the left pane and drag & drop the folder 

into the Shared Folders pane. If a message appears asking you to confirm the shared folder, select Yes.

<Method 1> <Method 2> <Method 3>

Cancelling a Shared Folder

You can cancel a shared folder on your PC. Select a folder from the Shared Folder pane and select Unshare Folder.

Method 1: Select a folder from the Shared Folder pane, select the Share menu and then select Unshare Folder.

Method 2: Select a folder from the Shared Folder pane, right-click over the selected folder and then select Unshare Folder 

from the pop-up menu.

Method 3: Locate the mouse pointer over a folder in the Shared Folder pane and drag&drop the folder into the My Computer 

pane. If a message appears asking you to confirm the cancelation, select Yes.

<Method 1> <Method 2> <Method 3>

Applying the Current Settings

Perform this when synchronization is necessary due to a new shared folder or cancelling a shared folder. The Set Changed State 

menu applies changes to shared folders to the data saved with the PC share programme.

Since applying changes to the internal data is a time-consuming process, this function enables users to apply changes to the data 

only when required.

Until the Set Changed State menu is selected, the changed state of the shared folder is not applied to the server.

Changes to the shared folders are not applied to your PC until you select the Set Changed State menu.

Method 1: Select the Share menu and select the Refresh DB sub-menu.

Method 2: Click the Set Changed State icon.

<Method 1> <Method 2>

 

❑
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Setting the Access Permission

To enable the TV to find your PC, the TV must be set to Set Device Policy in the Access Permission Settings window. In addition, 

the PC server and the TV must be on the same subnet.

Method: Select the Share menu and select Set Device Policy. Rejected items are represented in gray. You can change the 

access permissions by using the Allow Accept / Deny button. To delete an item, select the item and select Delete Item.

Server

Server

You can run or stop using your PC as a server.

Run DLNA Digital Media Server when Windows Starts

You can determine whether to start the PC server automatically when Windows starts.

Change server name

You can rename the PC server. Enter a new name and click OK. The new name will appear at the top right of the window and will 

appear on the TV.

Help

Version

The program version information message box appears.

Using the DLNA Function

Using the DLNA Menu

DLNA (Digital Living Network Alliance) enables content saved on a DLNA server (usually your PC) connected to your TV or over 

a network to be played. Media Play enables playing content saved on a USB memory device connected to the TV, while DLNA 

enables playing content saved on a DLNA server (your PC) connected to your TV or over the network. The procedures to use the 

content are the same as those for Media Play (USB & DLNA).

If you install the PC share manager program supplied with the TV onto a PC, you can have the PC perform the role of a DLNA 

server over the network.

For detailed procedures on using the DLNA menu, refer to the ‘Media Play’ instructions.

1. Press the MEDIA.P button on the remote control to display the DLNA menu.

2. Press the ◄ or ► button to select an icon (Photo, Music, Movie, Setup), then press the ENTERE button.

To exit DLNA mode, press the MEDIA.P button on the remote control.

DLNA does not support the following functions. 

The Background Music and Background Music Setting functions.

Sorting files by preference in the Photo, Music, and Movie folders.

The Change Group function.

The Copy / Delete function.

The Remove Safely function.

The REW/FF (π/μ) key functions while a movie is playing.

Playing Movie Continuously (Resume Play) function.

The Skip function may not work with some container such as asf and mkv.

The Divx DRM, Multi-audio, embedded caption does not supported.

Samsung PC Share manager should be permitted by the firewall program on your PC.

The Skip (◄/► keys) or Pause function may not work while a movie is playing for the DLNA of other manufacturers, 
depending on the corresponding content information.

The playing time may not be displayed while a movie is playing.
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ANYNET+

Connecting Anynet+ Devices

What is Anynet+?

Anynet+ is a function that enables you to control all connected Samsung devices that support Anynet+ with your Samsung TV’s 

remote. The Anynet+ system can be used only with Samsung devices that have the Anynet+ feature. To be sure your Samsung 

device has this feature, check if there is an Anynet+ logo on it.

To connect to a TV

1. Connect the HDMI IN (1, 2, 3 or 4) jack on the TV and the HDMI OUT jack of the corresponding Anynet+ device using an 

HDMI cable.

To connect to Home Theatre

1. Connect the HDMI IN (1, 2, 3 or 4) jack on the TV and the HDMI OUT jack of the corresponding Anynet+ device using an 

HDMI cable.

2. Connect the HDMI IN jack of the home theatre and the HDMI OUT jack of the corresponding Anynet+ device using an HDMI 

cable.

Connect the Optical cable between the DIGITAL AUDIO OUT (OPTICAL) jack on your TV and the Digital Audio Input on 

the Home Theatre.

When following the connection above, the Optical jack only outputs 2 channel audio. You will only hear sound from the 

Home Theatre’s Front Left and Right speakers and the subwoofer. If you want to hear 5.1 channel audio, connect the 

DIGITAL AUDIO OUT (OPTICAL) jack on the DVD / Satellite Box (ie Anynet Device 1 or 2) directly to the Amplifier or 

Home Theatre, not the TV.

Connect only one Home Theatre.

You can connect an Anynet+ device using the HDMI 1.3 cable. Some HDMI cables may not support Anynet+ functions.

Anynet+ works when the AV device supporting Anynet+ is in the Standby or On status.

Anynet+ supports up to 12 AV devices in total. Note that you can connect up to 3 devices of the same type.

Anynet+ supports up to 3 devices simultaneously.

¦
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Setting Up Anynet+

Press the TOOLS button to display the Tools menu. You can also display Anynet+ menu by 

selecting Tools	→	Anynet+ (HDMI-CEC).

Setup

Anynet+ (HDMI-CEC)	→	Off	/	On
To use the Anynet+ Function, Anynet+ (HDMI-CEC) must be set to On.

When the Anynet+ (HDMI-CEC) function is disabled, all the Anynet+ related operations are 

deactivated.

Auto	Turn	Off	→	No	/	Yes
Setting an Anynet+ Device to turn Off automatically when the TV is turned Off.

The active source on the TV remote must be set to TV to use the Anynet+ function.

If you set Auto Turn Off to Yes, connected external devices are also turned off when the 

TV is turned off. If an external device is still recording, it may or may not turn off.

Switching between Anynet+ Devices

1. Press the TOOLS button. Press the ENTERE button to select Anynet+ (HDMI-CEC).

2. Press the ▲ or ▼ button to select Device List, then press the ENTERE button.

Anynet+ devices connected to the TV are listed.

If you cannot find a device you want, press the red button to scan for devices. 

3. Press the ▲ or ▼ button to select a particular device and press the ENTERE button. It 

is switched to the selected device.

Only when you set Anynet+ (HDMI-CEC) to On in the Application menu, the Device 

List menu appears.

Switching to the selected devices may take up to 2 minutes. You cannot cancel the 

operation during the switching operation.

The time required to scan for devices is determined by the number of connected devices.

When the device scan is complete, the number of devices found are not displayed.

Although the TV automatically searches the device list when the TV is turned on via the power button, devices connected to 

the TV may not always be automatically displayed in the device list. Press the red button to search for the connected device.

If you have selected external input mode by pressing the SOURCE button, you cannot use the Anynet+ function. Make sure to 

switch to an Anynet+ device by using the Device List.

Anynet+ Menu

The Anynet+ menu changes depending on the type and status of the Anynet+ devices connected to the TV.

Anynet+ Menu Description

View TV Anynet+ mode changes to TV broadcast mode.

Device List Shows the Anynet+ device list.

(device_name) Menu
Shows the connected device menus. E.g. If a DVD recorder is connected, the disc 

menu of the DVD recorder will appear.

(device_name) INFO
Shows the play menu of the connected device. E.g. If a DVD recorder is connected, 

the play menu of the DVD recorder will appear.

Recording: (*recorder)
Starts recording immediately using the recorder. (This is only available for devices that 

support the recording function.)

Stop Recording: (*recorder) Stops recording.

Receiver Sound is played through the receiver.

If more than one recording device is connected, they are displayed as (*recorder) and if only one recording device is 

connected, it will be represented as (*device_name).
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TV Remote Control Buttons Available in Anynet+ Mode

Device Type Operating Status Available Buttons

Anynet+ Device

After switching to the device, when the 

menu of the corresponding device is 

displayed on the screen.

Numeric buttons

▲/▼/◄/►/wheel/ ENTERE buttons

Colour buttons / EXIT button

After switching to the device, while playing 

a file
π(Backward search) / μ(Forward search) / 

∫(Stop) / ∂(Play) / ∑(Pause)

Device with built-in 

Tuner

After switching to the device, when you 

are watching a TV program
P > / P < button

Audio Device When Receiver is activated Y / MUTE button

The Anynet+ function only works when the active source on the TV remote control is set to TV.

The ∏ button works only while in the recordable state.

You cannot control Anynet+ devices using the buttons on the TV. You can control Anynet+ devices only using the TV remote 

control.

The TV remote control may not work under certain conditions. If this occurs, reselect the Anynet+ device.

The Anynet+ functions do not operate with other manufacturers’ products.

The π, μ operations may differ depending on the device.

Recording

You can make a recording of a TV program using a Samsung recorder.

1. Press the TOOLS button. Press the ENTERE button to select Anynet+ (HDMI-CEC).

2. Press the ▲ or ▼ button to select Recording Immediately and press the ENTERE 

button. Recording begins.

When there is more than one recording device

When multiple recording devices are connected, the recording devices are listed. 

Press the ▲ or ▼ button to select a recording device and press the ENTERE 

button. Recording begins.

When the recording device is not displayed select Device List and press the Red 

button to search devices

3. Press the EXIT button to exit.

You can record the source streams by selecting Recording: (device_name).

Pressing the ∏ button will record whatever you are currently watching. If you are watching video from another device, 

the video from the device is recorded.

Before recording, check whether the antenna jack is properly connected to the recording device. To properly connect an 

antenna to a recording device, refer to the recording device’s users manual.

Listening through a Receiver (Home theatre)

You can listen to sound through a receiver instead of the TV speaker.

1. Press the TOOLS button. Press the ENTERE button to select Anynet+ (HDMI-CEC).

2. Press the ▲ or ▼ button to select Receiver. Press the ◄ or ► button to select On or Off.

3. Press the EXIT button to exit.

If your receiver supports audio only, it may not appear in the device list.

The receiver will work when you have properly connected the optical in jack of the 

receiver to the DIGITAL AUDIO OUT (OPTICAL) jack of the TV.

When the receiver (home theatre) is set to On, you can hear sound output from 

the TV’s Optical jack. When the TV is displaying a DTV(air) signal, the TV will send 

out 5.1 channel sound to the Home Theatre receiver. When the source is a digital component such as a DVD and is 

connected to the TV via HDMI, only 2 channel sound will be heard from the Home Theatre receiver.

If there is a power interruption to the TV when the Receiver is set to On (by disconnecting the power cord or a power 

failure), the Speaker Select may be set to External Speaker when you turn the TV on again.
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Troubleshooting for Anynet+

Problem Possible Solution

Anynet+ does not work. Check if the device is an Anynet+ device. The Anynet+ system supports Anynet+ devices only.

Connect only one receiver (home theatre).

Check if the Anynet+ device power cord is properly connected.

Check the Anynet+ device’s Video/Audio/HDMI 1.3 cable connections.

Check whether Anynet+ (HDMI-CEC) is set to On in the Anynet+ setup menu.

Check whether the TV remote control is in TV mode.

Check whether it is Anynet+ exclusive remote control.

Anynet+ doesn’t work in certain situations. (Searching channels, Operating Media Play, Plug & 
Play, etc.)

When connecting or removing the HDMI 1.3 cable, please make sure to search devices again or 
turn your TV off and on again.

Check if the Anynet+ Function of Anynet+ device is set on.

●
●
●
●
●
●
●
●

●

●
I want to start Anynet+. Check if the Anynet+ device is properly connected to the TV and check if the Anynet+ (HDMI-

CEC) is set to On in the Anynet+ Setup menu.

Press the TV button on the TV remote control to switch to TV. Then press the TOOLS button to 
show the Anynet+ menu and select a menu you want.

●

●

I want to exit Anynet+. Select View TV in the Anynet+ menu.

Press the SOURCE button on the TV remote control and select a device other than Anynet+ 
devices.

Press P >/<, PRE-CH, and FAV.CH to change the TV mode. (Note that the channel button 
operates only when a tuner-embedded Anynet+ device is not connected.)

●
●

●

The message 

‘Connecting to Anynet+ 

device...’ appears on the 

screen.

You cannot use the remote control when you are configuring Anynet+ or switching to a view 
mode.

Use the remote control when the Anynet+ setting or switching to view mode is complete.

●

●

The Anynet+ device does 

not play.

You cannot use the play function when Plug & Play is in progress.●

The connected device is 

not displayed.

Check whether or not the device supports Anynet+ functions.

Check whether or not the HDMI 1.3 cable is properly connected.

Check whether Anynet+ (HDMI-CEC) is set to On in the Anynet+ setup menu.

Search Anynet+ devices again.

You can connect an Anynet+ device using the HDMI 1.3 cable only. Some HDMI cables may not 
support Anynet+ functions.

If it is terminated by an abnormal situation such as disconnecting the HDMI cable or power cord 
or a power failure, please repeat the device scan.

●
●
●
●
●

●

The TV program cannot 

be recorded.

Check whether the antenna jack on the recording device is properly connected.●

The TV sound is not 

output through the 

receiver.

Connect the optical cable between TV and the receiver.●

¦
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CONTENT LIBRARY

Using the Content Library

The Content Library allows you to enjoy various content on your TV. You can use the default 

content stored in the TV memory or you can enjoy new content using a USB device or via the 

Internet.

Using the Content Library Menu

1. Press the MENU button. Press the ▲ or ▼ button to select Application, then press the 

ENTERE button.

2. Press the ▲ or ▼ button to select Content Library, then press the ENTERE button.

The Content Library main menu is displayed.

3. Press the ◄ or ► button to select an icon (Gallery, Cooking, Game, Children, Wellness, 

Others, Content Management), then press the ENTERE button.

Using the Remote Control Button in Content Library Menu

Button Operations

▲/▼/◄/► Move the cursor and select an item.

ENTERE Select the currently selected item.

RETURN Return to the previous menu.

EXIT Stop the current function and return to the Content Library main menu.

< P > Stop Content Library mode and Returns to TV mode.

Colour button Keys that provide functions are described on the corresponding page.
Y / MUTE You can control the volume of the played content.

CONTENTS LIBRARY CONTAINS TEXT, GRAPHICS, IMAGES, MULTIMEDIA, AND OTHER MATERIALS FOR 

INFORMATIONAL AND PROMOTIONAL PURPOSES ONLY. MATERIALS IN CONTENTS LIBRARY HAS BEEN MODIFIED 

AND KEEPS BEING REVISED AND UPDATED. THE MATERIALS IN THE CONTENTS LIBRARY MAY NOT BE SUITABLE 

FOR ALL AUDIENCES.

INFORMATION IN THE CONTENTS LIBRARY IS PROVIDED ‘AS IS.’ ALTHOUGH THE INFORMATION PROVIDED TO YOU 

IN THE CONTENTS LIBRARY IS OBTAINED OR COMPLIED FROM SOURCES WE BELIEVE TO BE RELIABLE, SAMSUNG 

CANNOT AND DOES NOT GUARANTEE THE ACCURACY, VALIDITY, TIMELINESS OR COMPLETENESS

OF ANY INFORMATION OR DATA MADE AVAILABLE TO YOU FOR ANY PARTICULAR PURPOSE. UNDER NO 

CIRCUMSTANCES, INCLUDING NEGLIGENCE, SHALL SAMSUNG BE HELD LIABLE, WHETHER IN CONTRACT OR TORT, 

FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL OR CONSEQUENTIAL DAMAGES, ATTORNEY FEES, EXPENSES, 

OR ANY OTHER DAMAGES WHATSOEVER ARISING OUT OF, OR IN CONNECTION WITH, ANY INFORMATION 

CONTAINED IN, OR THE USE OF, THE CONTENTS LIBRARY, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH 

DAMAGES.

¦
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Using the TV Memory Contents

You can use enjoy content stored in the TV memory. You can add/delete content to/from the TV memory. To add/delete content, 

select Content Management.

To return to Content Library main menu, press the EXIT button.

Gallery

This function plays a SlideShow with high resolution images and background music and 

produces various atmospheres. Using the Gallery function of the TV, you can change your home 

atmosphere.

The copyrights of the Gallery contents and all issues related to them are reserved by 

TimeSpace, Inc. 

Press the ENTERE button to pause the SlideShow, and also press the ENTERE button 

to resume the SlideShow.

Press the INFO button to display information on the selected photo. (This is not displayed if the photo has no information.)

Cooking

You can view various recipes and then easily follow them step by step. Enjoy these contents which will give you great ideas for 

meals.

The recipes introduced in the Cooking contents on the Samsung TV are based on recipes published by Anness Publishing.

The copyrights of the Cooking contents and all issues related to them are reserved by Practical Pictures.

Game

This category provides entertainment games for the whole family.

For the buttons used in the games, refer to the directions on the screen.

Colour Buttons for Games

Button Operations

Red Press to move to the game home screen

Green Press to pause the game

Yellow Option Key

Blue Press to exit the game

Children

This is educational and interactive content that children can watch repeatedly. 

The copyrights of the Children contents and issues related to them reserved by UpToTen.

Wellness

This is beneficial health management content that provides stretching and massage exercises that can be enjoyed by the whole 

family.

Others 

The default content is not saved in the TV memory.

You can copy new content to the TV memory using the Content Management screen.
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Using the Content Management

Content Management

You can add or delete contents using the Content Management.

You can select multiple content items by selecting content items repeatedly and pressing 

the Yellow button.

My Contents

You can check the content saved in the TV memory for each subitem of the Content Library.

Select a content item and press the ENTERE button. You can play or delete the selected 

content item.

USB

You can check the content saved on the USB device for each subitem of the Content Library.

Select a content item and press the ENTERE button. You can play the selected content 

item or copy it to the TV memory.

Content Library only supports USB Mass Storage Class devices (MSC). MSC is a Mass Storage Class Bulk-Only 

Transport device. Examples of MSC are Thumb drives and Flash Card Readers.

Playing a game using an external USB memory device will allow you to save your game (depending on the game). Take 

care as removing the USB memory device while saving data to the USB memory device may cause the data to be lost.

Downloading New Contents

New content other than the built-in content will be provided via the Samsung.com website with or without charge. Check 

the UDN number before downloading a new content item. You have to enter the UDN number on the Samsung.com 

website to download a content item.

Downloading Content

1. Visit the www.samsung.com website and open the Content Library page.

2. Enter the product number (UDN, Unique Device Number).

3. Select a content item in the Contents Download page.

4. Download the contents onto the USB memory device.

�. Go to Content Library main menu by pressing CONTENT button or choosing Content Library (Menu → 
Application	→	Content	Library).

�. Plug the USB memory into USB port on the side of the TV.

Provided Content

Additional content is available on www.samsung.com

Setup

Screen Saver Run Time: Select to set the waiting time before the screen saver appears.

Save UDN: Saves the UDN number to a USB device.

An NTFS format USB storage device does not support saving UDN. We recommend using a FAT format USB storage device.
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INTERNET@TV
This function may not be supported depending on your country.

Getting Started with Internet@TV

Internet@TV provides Yahoo’s widget services through a network connection. You can access various information such as world 

weather, stock news, as well as the latest news through the Internet@TV service. 

If Network condition is unstable, this function may not work. Then, TV would be turned off automatically. Otherwise turn off the 

TV using power button.

You may experience slow operation or hesitation when using this function due to network conditions.

When running Internet@TV for the first time, the basic settings will proceed automatically.

Before using Internet@TV, set up the network first. For more information on how to configure your network, refer to ‘Setting 

the Network’.

1. Press the MENU button. Press the ▲ or ▼ button to select Application, then press the ENTERE button.

2. Press the ▲ or ▼ button to select Internet@TV, then press the ENTERE 

button.

INTERNET@TV starts.

Press the Internet@ button on the remote control to display the Internet@

TV menu.

3. The General Disclaimer is displayed on the screen. Select I accept or I do not accept.

For more information on the General Disclaimer, refer to the ‘Legal Notice’.

4. A service update is performed automatically on the TV.

When updating is finished, a brief introduction to Internet@TV is displayed.

�. Select Let’s get started!

If you select Exit Setup, the setup is resumed from the introduction when you 

run Internet@TV next time.

�. The country selection screen is displayed. Select the country.

The configuration of Widgets and their provided services may differ according 

to the selected country.

�. The ‘Yahoo! TV WIDGET ENGINE PRIVACY POLICY’ is displayed. Select OK, I 

Accept to agree to the agreement.

�. The ‘Yahoo! TV Widget System Terms of Service’ are displayed. Select OK, I 

Accept to agree to the agreement.

9. The set name screen is displayed. Enter the name and select Save this name.

You can use the Internet@TV service with a personally configured profile. For 

more information, refer to ‘Using the Profile Widget’.

10. Test the TV’s network connection.

If the network connection test fails, configure your network again. For more 

information on how to configure your network, refer to ‘Setting the Network’.

11. The basic settings are finished. then a description on how to use Internet@TV is displayed.

If you want to view a brief description on again how to use Internet@TV, select Profile	→	System	Setting	→	Repeat	
Tutorial.

12. Internet@TV runs.
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Welcome	to	Yahoo!®	TV	Widgets!

Yahoo!	TV	Widgets	bring	the	best	of	the	internet	to	
your	TV!	You	can	get	updated	weather	conditions	or	
sports	scores,	get	updated	information	on	stocks,	or	
even	view	full-screen	photos	and	video!

We	just	need	to	get	a	few	things	set	up,	and	you’ll	be	
on	your	way!

Let’s	get	started! Exit	setup

1

What’s	your	name?

Each	person	in	the	house	who	
uses	the	TV	can	have	their	own	
personalized	set	of	widgets.
We’ll	keep	track	of	these	
individual	widget	profiles	by	the	
name	you	enter,	Enter	the	name	
YOU	want	to	use	now.

Save	this	name

5

Skip	this	step Exit	setup
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Screen display

Dock mode

1 Welcome banner: The current selected profile is displayed.

The banner disappears after 5 seconds automatically.

2 Help Items

Blue (Viewport) button: Configure the viewport.

Yellow (Edit Snippet) button: You can rearrange or delete a 

widget by pressing the Yellow button.

3 Snippet dock: The Snippets are displayed. You can select the desired 

widget by pressing the ◄ or ► button on the remote control.
It may take a few seconds to load the snippet.

Profile widget and Gallery widgets cannot be deleted from the 

snippet dock.

For more information on how to configure your snippet dock, refer to ‘Configure the Internet@TV Screen’.

Sidebar mode

1 The Widget’s Home: The currently selected widget is displayed.

2 Currently menu: The currently selected menu is displayed.

If you want to go to the previous menu, select it or press the 

RETURN button.

If you want to go to the Dock mode, press the INTERNET@ 

button.

3 Current selection: The currently selected contents is highlighted.

4 The current page: The current page is displayed.

You can move the page by pressing the ◄ or ► button.
5 Help Items

Red button: Close the widget.

Green button: Manage your snippets.

Yellow button: Change the widget’s setting.

Blue button: Size video to fit, or make it full screen.

Configuring the Internet@TV Screen

Internet@TV allows you to move or delete a widget in accordance with your preferences.

Change the settings of the Internet@TV screen according to your preferences.

What is a Widget?

A TV Widget is a small web application that allows you to easily access your favourite site using the remote control. You can enjoy 

various types of information, such as the latest news, weather information, and stock information, etc. on your TV along with your 

friends or family members.

Some widgets may not be supported depending on the regulations of the corresponding country. 

Some widgets will only support limited services depending on the regulations of the corresponding country.

The colour buttons may work differently depending on the widget.

The operation may not be smooth depending on the network condition.

The Snippet is a symbol of Widget.

What is a Snippet?

A snippet shows a part of the Widget contents such as weather and stock information that the user wants to view.

The snippets are automatically updated in real time.

It may take a few seconds to load the snippet.
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Configuring the Viewport

Configure the viewport by pressing the Blue button on the remote control.

The viewport is a small TV screen that displays the original TV screen at a reduced size while maintaining the aspect ratio. 

This prevents a widget or setup screen of the Internet@TV from hiding part of the TV 

screen.

Moving and Deleting a Widget

You can arrange widgets as desired.

Select a widget you want to move and press the Yellow button.

Moving a Widget

When the menu is displayed, press the Blue button and select Move.

Move the selected widget to the desired position using the remote control and press the Yellow button to complete the setting.

Deleting a Widget

When the menu is displayed, press the Red button and select Delete.

The selected widget is deleted.

The deleted widget can be reinstalled. For more information on how to install a widget, refer to the ‘Using the Widget Gallery’.

Using the Profile Widget

You can configure various settings related to a profile using a profile widget.

Switch Profile

You can register multiple profiles. Each profile saves the settings for the corresponding widget. If 

multiple profiles are registered, you can switch between them.

At least two profiles must be registered. If you want to add a profile, refer to ‘Administrative 

Controls’.

Profile Settings

Changes the information of the profile.

Name

You can change the profile name.

Avatar

An avatar is a small, modifiable representation of the user. You can change the avatar of the profile. 

Create Profile PIN

You can set the PIN of the profile.

When setting the PIN for the first time, you can set a Security	Question.

Security	Question
Set this for when you forget the Profile PIN. You can select a personal question from the list.
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Limit Profile

You can restrict the installation of the widget for the profile.

The Owner PIN must be set to use this function. To set the Owner PIN, refer to ‘Administrative Controls’.

Limit Profile

You can restrict the installation of the widget for the profile.

The Owner PIN must be set to use this function. To set the Owner PIN, refer to ‘Administrative Controls’.

System Settings

Location

You can select your location with this item.

Zip code (US only)

You can set your zip code.

Repeat Tutorial

You can view the tutorial again.

Restore Factory Settings

Internet@TV is reset to its default status and all the changes to the settings you made are 

removed.

When you cannot run Restore Factory Settings normally,

Press the remote control buttons in the following sequence, which resets the Internet@TV: 

MUTE	→	9	→	4	→	8	→	EXIT

Administrative Controls

Screen Saver

Select to set the waiting time before the screen saver appears.

Create Owner PIN

You can set the PIN of the Administrative Controls.

When setting the PIN for the first time, you can set a Security Question.

Create Profile

You can create a new profile.

Remove Profile

You can delete a selected profile.

Sign in to Yahoo! (or Sign Out of Yahoo!)

If you have a Yahoo! account, you can login to your account via Internet@TV. To experience more 

Internet@TV functions, login with a Yahoo! account.

Only one login account is available for each profile. 

If you have no Yahoo! account, visit www.yahoo.com and create an account. 

You may fail to log in with an ID created on the Yahoo website in a country that does not 

support Internet@TV.

About Profile widget

Press the Green button.

You can view a brief description of the Profile Widget, Copyright Policy, Terms of Service, and 

Privacy Policy..
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Using the Weather Widget

Your TV allows you to view the weather information for multiple cities of the world provided by a 

website. You can view the current weather and weather forecast using the remote control.

Selecting a City

You can add or delete a city for which you want to view weather information.

Configure the Weather Settings by pressing the Green button.

Add new city 

Enter the name of the city you want to add. You only need to enter a part of the name of the city to 

search for it automatically.

Select the city you want to add from the list. Press the ENTERE button to add it to the list.

The selected city is added to the added city list.

Delete city 

Select the city you want to delete from the added city list. Press the ENTERE button to delete it.

Changing the Temperature Indication Mode

You can change the temperature indication mode to Imperial or Metric. For example, Imperial will 

show temperatures in Fahrenheit and Metric in Celsius.

Configuring a Snippet 

A snippet can open a Widget or it can be a shortcut to a specific place in a Widget.

1. If you select a city in the added city list, you can view detailed information on the weather forecast and the current weather for 

that city.

2. You can add or delete a snippet by pressing the Yellow button.

If a snippet is configured, you can view the weather information in the widget.

About Weather widget

Press the Green button. You can view a brief description of the weather widget, Copyright Policy, Terms of Service, and Privacy 

Policy.

Using the News Widget

Your TV allows you to view the latest headline news provided by a website. You can view in detail 

the headline news of each category using the remote control.

About News widget

Press the Green button.

You can view a brief description of the news widget, Copyright Policy, Terms of Service, and 

Privacy Policy.
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Using the Flickr Widget

You can use Flickr which allows you to manage and share photos online. You and your family can 

use the TV to enjoy files uploaded by users or recently updated photos on a website.

Most Flickr widget functions can only be used if you have a Yahoo! account. If you have no 

Yahoo! account, visit www.yahoo.com and create an account. 

For detailed procedures on log in, refer to the ‘Using the Profile Widget’ instructions.

For more information on Flickr, visit www.flickr.com.

Your Photos

You can view photos you have registered with Flickr.

Uploading a photo is only possible through the website.

Using a Slideshow 

Selects a thumbnail photo. Select Start Slideshow to view a slideshow of thumbnail photos.

If you press the ENTERE button during a slideshow, the thumbnails of the photos being 

played are displayed.

You can use pause (or play) and stop the slideshow.

If you click on i, you can view information for the selected photo.

Your Sets

You can view the sets that you classified in Flickr.

Setting up sets is only possible through the website.

Explore

Displays the photos updated on the website. You can view the photos updated daily.

Mark as Favorite (or Remove From Favorite)

Moves photos to the Favourites Photos or removes photos from it.

Favourites Photos

You can set your Favourites Photos through the Internet@TV or the website.

Your Contacts

You can view news from your family and friends.

Your Groups

You can select multiple groups on the Flickr website. There are thousands of groups in Flickr. You can share and enjoy interesting 

photos with other users.

Configuring the Flickr Options 

Press the Green button.

Time Per Slide

Select to control the slide show speed.

Repeat

Select to repeatedly play photo files.
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Using the Finance Widget

YYou can view stock information and the latest stock news provided by a website on your TV.

Setting up My Stocks 

You can add or delete a stock.

Press the Green button to begin setting up My Stocks.

Add New Symbol...

Enter the name of the stock to add. You can enter only a part of the name of the stock to search for 

it automatically.

Select the stock you want to add from the list and press Add Symbol to add it.

The selected stock is added to the My Stocks list.

You can delete a stock from the My Stocks list.

Import Symbols From Yahoo!... 

You can retrieve your Yahoo Finance portfolio and import it into the TV widget. 

Merge Symbols: Merges the symbols registered to the TV and the portfolio registered to the 

website.

Replace Symbols: Deletes symbols registered to the TV and retrieves the portfolio registered 

to the website.

For detailed procedures on log in, refer to the ‘Using the Profile Widget’ instructions.

Display Format

You can change the display format of the stock-price fluctuation transition to Value or Percentage.

Configuring a Snippet

A snippet can open a Widget or it can be a shortcut to a specific place in a Widget.

1. If you select a stock in the added stock list, you can view detailed information and the latest news on it.

2. You can add or delete a snippet by pressing the Yellow button.

If you set up a Snippet, you can view stock information in the widget.

About Yahoo! Finance...

Press the Green button.

You can view a brief description for the Finance widget, Copyright Policy, Terms of Service, and Privacy Policy.

Using the Widget Gallery

On the Internet@TV, you can add and use various widgets provided by your Internet service. More 

widget content services will be provided in the future.

Adding a Widget 

You can select and install a widget from a category selected in Categories.

Latest Widgets: Displays recently updated widgets.

Yahoo! Widgets: Displays widgets provided by Yahoo!

Samsung Widgets: Displays widgets provided by Samsung. 

Categories: You can view all widgets by the category.
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Widget Gallery Settings

Press the Green button.

About Yahoo! Widget Gallery...

You can view brief information for the Widget Gallery, Copyright Policy, Terms of Service, and 

Privacy Policy.

Developer Settings

You can make your own widget.

For more information, Please visit our developer site at http://connectedtv.yahoo.com/ with the 

developer code. 

If you set Show My Test Widgets to On, you can access the widgets you created in the Widget 

Gallery. For more information on Test Widgets, visit www.connectedtv.yahoo.com
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Developer	Settings
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INTERNET@TV
This function may not be supported depending on your country.

Getting Started with Internet@TV

Internet@TV provides SAMSUNG’s widget services through a network connection. You can access various information such as 

YouTube, as well as the latest news through the Internet@TV service. 

The configuration of Widgets and their provided services may differ according to the selected country. For more information on 

how to configure your country, refer to the ‘Channel Menu’ instructions. 

You may experience slow operation or hesitation when using this function due to network conditions.

When running Internet@TV for the first time, the basic settings proceed automatically.

Before using Internet@TV, set up the network first. For more information on how to configure your network, refer to ‘Setting 

the Network’.

1. Press the MENU button. Press the ▲ or ▼ button to select Application, then press the ENTERE button.

2. Press the ▲ or ▼ button to select Internet@TV, then press the ENTERE button.

Press the Internet@ button on the remote control to display the Internet@TV menu.

3. The ‘User Agreement’ is displayed. Select Agree to accept the agreement.

4. The ‘Statistics & Analysis’ is displayed. Select Agree to accept the agreement.

A service can be updated automatically on the TV.

Setting up Internet@TV

You can check and use the menus regarding Single Sign On (SSO), system management and properties. Press the ▲ or ▼ 
button to select Setup, then press the ENTERE button.

Single Sign On

You can use this menu when creating, deleting the account.

Using the Single Sign On, you can control your account including contents site’s account information.

You don’t need additional log in.

Account is only for internet@TV.

Create Account

You can create account and be linked with desired service site.

Account will be made less than 10.

Character of Account should be limited to 10 words.

If there is no service that needs log in, you can not create account.

Account Management

Service Site: You can register log in information of service site.

Change Password: Change the password of your account.

Delete: Delete the account.

System Setup

Change the Service Lock password

The default password number of a new TV set is 0-0-0-0.

Service	Duration	→	2	Hours	/	4	Hours	/	8	Hours	/	No	limit
Select to set the service duration time before the screen saver appears.

Ticker	Autorun	→	Off	/	On
Select to set ticker to run automatically or not when turning on the TV.

Ticker	Duration	→	2	Hours	/	4	Hours	/	8	Hours	/	No	limit
Select to set the service duration time before the screen saver appears.

Properties

Display information of Internet@TV

You can measure the speed of your Internet TV service using Measuring the speed of the Internet TV service.
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Using the Internet@TV service

In a widget that provides multiple category menus, you can view the contents of the category menus using the ◄ and ► buttons.

Account Login

1. Press the Red button.

2. Select desired User account, then press the ENTERE button.

3. Input the password.

When login succeeds, User account will be displayed on the screen.

Before login, at least one and more account should be registered. If you want to create account, refer to ‘Setting up 

Internet@TV’.

Using the Widget Gallery

For uninstalled widgets, the descriptions about the corresponding services are displayed.

Run Service: Runs the widget service.

Lock: Set the service lock

Install Service/Delete Service: Install or delete widget service.

Using the Ticker

If a service has the Ticker function from among the widgets installed on the Internet@TV, you can use the service using the 

Ticker even while watching TV.

For information about configuring the Ticker, refer to the ‘Setting Up Internet@TV’.

The Ticker and captions are not displayed simultaneously.

To exit Ticker mode, press the EXIT or RETURN button on the remote control.

Using the YouTube Widget

You can watch the movie provided by YouTube.

If you have the account in YouTube, Register account information using Account 

management. Then, you can use My Favourites category.

The menu can be changed by web service.

There may be inappropriate contents for child. In this case, use Lock function in 

Widget Gallery.

Using the News Widget

You can view the news provided by service provider.

The widget menu can vary by service provider.
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Mobile phone

Wireless IP sharer

LAN Cable

HOME NETWORK CENTRE

Home Network Centre

About the Home Network Centre

The Home Network Centre connects the TV and mobile phones through a network. You can view call arrivals, text message 

contents, and schedules set on the mobile phone on the TV using the Home Network Centre. In addition, you can play the media 

contents saved on the mobile phones such as videos, photos and music by importing them onto the TV via the network.

If the device supports DLNA DMC (Digital Media Controller) function, Home Network Centre function is available.

The Samsung SGH-i900 mobile phone supports the Home Network Centre. Other models will be added in the future.

The mobile device may need additional software installation. For details, refer to each user’s guide.

To play media contents on the TV, you need a mobile phone or PDA(Personal Digital Assistant) that supports the DLNA DMC 

(Digital Media Controller) function.

Connecting to the Home Network Centre 

For more information about the network settings, refer to ‘Configuring the Network’.

Connecting to a WLAN Ad-hoc network

1. Connect the ‘Samsung Wireless LAN Adapter’ to the USB1(HDD) or USB2 port of the TV.

2. For more information on how to configure Ad-hoc network, refer to ‘Setting the Network’.

For information on configuring the mobile phone’s network settings, refer to the mobile phone manual.

3. Set up the IP address, SSID and password for the mobile phone in the Ad-hoc Settings of the mobile phone using the Network 

Name (SSID) and Security Key (password) displayed on the TV.

Connecting through a Wireless IP sharer 

1. Connect the LAN port of the TV and the Wireless IP sharer using the LAN cable.

Although the LAN port is connected, the network settings are configured for the wireless network.

For the procedures to set up the wireless sharer and the mobile phone, refer to the manual of the corresponding device.

¦

N
N
N
N

●

N

●

N

N

Mobile phone

TV Side Panel

Samsung Wireless or 

LAN Adapter
or

2009-02-13    9:52:43



English - �2

Setting Up the Home Network Centre

Message 

Shows a list of mobile phones which have been set up with this TV to use the 

message function (the call arrivals, text message contents and schedules set on the 

mobile phone).

Allowed

Allows the mobile phone.

Denied

Blocks the mobile phone.

Delete

Deletes the mobile phone from the list.

This function just deletes the name from the list. If the deleted mobile device turns on or tries to connect to the TV, it may be 

shown on the list.

Media 

Shows a list of mobile phones which is available to control media contents (videos, 

photos, music) from the phone.

Besides mobile phone, other mobile devices that support DLNA DMC are available.

Allowed

Allows the mobile phone.

Denied

Blocks the mobile phone.

Delete

Deletes the mobile phone from the list.

This function just deletes the corresponding name on the list. If the deleted mobile device turns on or tries to connect to the 

TV, it may be shown on the list.

Setup

Message	→	On	/	Off
You can determine whether to use the message function (the call arrivals, text message 

contents, and schedules set on the mobile phone).

Media	→	On	/	Off
You can select whether to use the play function that plays the contents (videos, photos, 

music) from the mobile phone. 

TV name

You can set the TV name so as to find it easily on the mobile device.

If you selects User Input, you can type the TV name by OSK(On Screen 

Keyboard).
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Message	 :	On
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Message
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	R	Return					e	Exit
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111-1234-5672	 :	Allowed

111-1234-5673		 :	Denied

111-1234-5674		 :	Denied

Home	Network	Centre	

Message

Media

Setup

	R	Return					e	Exit
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111-1234-5674		 :	Denied

Home	Network	Centre	
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	R	Return					e	Exit
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Using the Message Function

Using this function, you can view the call arrivals, text message contents and schedules 

set on the mobile phone through the alarm window while watching TV. 

To disable this Message alarm window, set Message to Off in Setup of the Home 

Network Centre.

The alarm window appears for 20 seconds. If no key is pressed or if Cancel is 

selected, it appears up to three times at 5 minute intervals.

If OK is selected, or if OK is not selected while the message is displayed three 

times, the message will be deleted. The message is not deleted from the mobile 

phone. 

The simple alarm window can be displayed, while using some applications such as 

Media Play, Contents Library, etc. In this case, to view the contents of the message, 

switch to TV viewing mode.

When the message of an unknown mobile phone is displayed, select the mobile 

phone in the Message item of the Home Network Centre and select Denied to 

block the phone.

Message View

If a new test message (SMS) arrives while you are watching TV, the alarm window 

appears. If you click the OK button, the contents of the message are displayed.

If you select the OK button, the contents of the message are displayed.

If you select the Cancel button, the alarm window appears up to three times at 5 

minute intervals.

You can configure the viewing settings for the text message (SMS) contents on the 

mobile phone. For the procedures, refer to the mobile phone manual.

Some special characters may be displayed as blank or broken characters.

Call Arrival Alarm

If a call arrives while you are watching TV, the alarm window appears.

If you select the OK button, the call arrival alarm is confirmed and the alarm 

window is closed.

If you select the Cancel button, the alarm window appears up to three times at 5 

minute intervals.

Schedule Alarm

While you are watching TV, the alarm window appears to display the registered 

schedule.

If you select the OK button, you can view the contents of the schedule registered 

on the mobile phone.

If you select the Cancel button, the alarm window appears up to three times at 5 

minute intervals.

You can configure the viewing settings for the schedule contents on the mobile 

phone. For the procedures, refer to the mobile phone manual.

Some special characters may be displayed as blank or broken characters.
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Photo
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SUM 		Device

PHOTO

R	Return

Music Movie Setup
husband

husband
SMS

OK Cancel

New	message	received
Do	you	want	to	view

the	details?

husband
SMS

OK Cancel

New	message	received
Do	you	want	to	view	

the	details?

husband
Call

OK Cancel

You	have	a	phone	call
Mom

011-298-2030

husband
Scheduled	event

OK Cancel

You	have	a	schedule
Do	you	want	to	view	

the	details?
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Using the Media Function

An alarm window appears informing the user that the media contents (videos, photos, music) sent from the mobile phone will be 

displayed on the TV.

The contents are played automatically 3 seconds after the alarm window appears.

If you press the RETURN or EXIT button when the alarm window appears, the Media Contents are not played.

To turn off the media contents transmission from the mobile phone, set Media to Off in Setup of the Home Network Centre.

The contents may not be played on the TV depending on their resolution and format.\

\Media play control buttons

Button Operations

◄/►
Move the cursor and select an item.

While playing a movie file: Move forwards or backwards through the movie file in 10 second interval.

ENTERE
Pressing the ENTERE button during play pauses the play.

Pressing the ENTERE button during pause resumes the play.

RETURN Return to the previous menu.

TOOLS Run various functions from the Photo, Music and Movie menus.

INFO Show file information.

EXIT Stop Media Play mode and Returns to TV mode.

The ENTERE and ◄/► buttons may not work depending on the type of media content. 
Using the mobile device, you can control playing media. For details, refer to each user’s guide.
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RECOMMENDATIONS

Teletext Feature

Most television stations provide written information services via Teletext. The index page of the Teletext service gives you 

information on how to use the service. In addition, you can select various options to suit your requirements by using the remote 

control buttons.

For Teletext information to be displayed correctly, channel reception must be stable. Otherwise, information may be missing or 

some pages may not be displayed.

1 : (exit)

Exit from the Teletext display.

2 0 (mode)

Press to select the Teletext mode 

(LIST/ FLOF). If you press it in 

the LIST mode, it switches into 

the List save mode. In the List 

save mode, you can save Teletext 

page into list using the 8(store) 

button.

3 8 (store)

Used to store the Teletext pages.

4 4 (size)

Press to display the double-size 

letters in the upper half of the 

screen. For lower half of the 

screen, press it again. To display 

normal screen, press it once 

again.

5 Colour buttons (red/green/yellow/

blue)

If the FASTEXT system is used 

by a broadcasting company, the 

different topics covered on a 

Teletext page are colour-coded 

and can be selected by pressing 

the coloured buttons. Press 

one of them corresponding 

to the required. The page is 

displayed with other coloured 

information that can be selected 

in the same way. To display the 

previous or next page, press the 

corresponding coloured button.

6 / (Teletext on/mix)

Press to activate Teletext mode after 

selecting the channel providing the 

Teletext service. Press it twice to 

overlap the Teletext with the current 

broadcasting screen.

7 5 (reveal)

Used to display the hidden text 

(answers to quiz games, for example). 

To display normal screen, press it 

again.

8 1 (sub-page)

Used to display the available sub-page.

9 2 (page up)

Used to display the next Teletext page.

0 3 (page down)

Used to display the previous Teletext 

page.

! 9 (hold)

Used to hold the display on a given 

page if the selected page is linked with 

several secondary pages which follow 

on automatically. To resume, press it 

again.

@ 6 (index)

Used to display the index (contents) 

page at any time while you are viewing 

Teletext.

# 7 (cancel)

Used to display the broadcast when 

searching for a page.

You can change Teletext pages by pressing the numeric buttons on the remote control. 
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The Teletext pages are organized according to six categories:

Part Contents

A Selected page number.

B Broadcasting channel identity.

C Current page number or search indications.

D Date and time.

E Text.

F Status information.

FASTEXT information.

Teletext information is often divided between several pages displayed in sequence, which can be accessed by:

Entering the page number

Selecting a title in a list

Selecting a coloured heading (FASTEXT system)

Teletext level supported by the TV is version 2.5 which is capable of displaying additional graphics or text.

Depending upon the transmission, blank side panels can occur when displaying Teletext.

In these cases, additional graphics or text is not transmitted.

Older TV’s which do not support version 2.5 are not capable of displaying any additional graphics or text, regardless of the 

Teletext transmission.

Press the TV button to exit from the Teletext display.

Installing the Stand

Preset: Place the Guide Stand and Cover Neck onto the stand and fasten it using the 

screws. Applicable to 32inch models only.

1. Attach your LCD TV to the stand.

Two or more people should carry the TV.

Make sure to distinguish between the front and back of the stand when assembling 

them.

To make sure the TV is installed on the stand at a proper level, do not apply excess 

downward pressure to the upper left of right sides of the TV.

2. Fasten screws at position 1 and then fasten screws at position 2.

Stand the product up and fasten the screws. If you fasten the screws with the LCD TV 

placed down, it may lean to one side.
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Disconnecting the Stand

1. Remove four screws from the back of the TV.

2. Separate the stand from the TV.

Two or more people should carry the TV.

3. Cover the bottom hole with the cover.

Installing the Wall Mount Kit

Wall mount items (sold separately) allow you to mount the TV on the wall.

For detailed information on installing the wall mount, see the instructions provided with the 

Wall Mount items. Contact a technician for assistance when installing the wall mounted 

bracket.

Samsung Electronics is not responsible for any damage to the product or injury to yourself or 

others if you elect to install the TV on your own.
Do not install your Wall Mount Kit while your TV is turned on. It may result in personal 

injury due to electric shock.

Remove the stand and cover the bottom hole with a cap and fasten with two screws.

Assembling the Cables

Enclose the cables in the Holder-Wire Cable so that the cables are not visible through the 

transparent stand.

Anti-Theft Kensington Lock

The Kensington Lock is a device used to physically fix the system when using it in a public 

place. The appearance and locking method may differ from the illustration depending on the 

manufacturer.

Refer to the manual provided with the Kensington Lock for proper use. 

The locking device has to be purchased separately.

The location of the Kensington Lock may be different depending on its model.

1. Insert the locking device into the Kensington slot on the LCD TV (1) and turn it in the 

locking direction (2).

2. Connect the Kensington Lock cable (3).

3. Fix the Kensington Lock to a desk or a heavy stationary object.
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Securing the TV to the Wall

Caution: Pulling, pushing, or climbing on the TV may cause the TV to fall. In particular, ensure your 

children do not hang over or destabilize the TV; doing so may cause the TV to tip over, causing serious 

injuries or death. Follow all safety precautions provided on the included Safety Flyer. For added stability, 

install the anti-fall device for safety purposes, as follows.

To avoid the TV from falling:

1. Put the screws into the clamps and firmly fasten them onto the wall. Confirm that the 

screws have been firmly installed onto the wall.

You may need additional material such as an anchor depending on the type of 

wall.

Since the necessary clamps, screws, and string are not supplied, please 

purchase these additionally.

2. Remove the screws from the centre back of the TV, put the screws into the clamps, 

and then fasten the screws onto the TV again.

Screws may not be supplied with the product. In this case, please purchase the 

screws of the following specifications. 

Screw Specifications

For a 32 ~ 40 Inch LCD TV: M6 X 15

3. Connect the clamps fixed onto the TV and the clamps fixed onto the wall with a strong 

string and then tie the string tightly.

Install the TV near to the wall so that it does not fall backwards.

It is safe to connect the string so that the clamps fixed on the wall are equal to or 

lower than the clamps fixed on the TV.

Untie the string before moving the TV.

4. Verify all connections are properly secured. Periodically check connections for any 

sign of fatigue for failure. If you have any doubt about the security of your connections, 

contact a professional installer.
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Troubleshooting: Before Contacting Service Personnel

No sound or picture Check that the mains lead has been connected to a wall socket.
Check that you have pressed the button on your set.
Check the picture contrast and brightness settings.
Check the volume.

Normal picture but no sound Check the volume.
Check whether the MUTEM button has been pressed on the remote control.
Check the Speaker Select settings.

Screen is black and power 

indicator light blinks steadily

On your computer check; Power, Signal Cable.
The TV is using its power management system.
Move the computer’s mouse or press any key on the keyboard.

No picture or black and white 

picture

Adjust the colour settings.
Check that the broadcast system selected is correct.

Sound and picture interference Try to identify the electrical appliance that is affecting the set and move it further away.
Plug your set into a different mains socket.

Blurred or snowy picture, 

distorted sound

Check the direction, location and connections of your aerial.
This interference is often due to the use of an indoor aerial.

Remote control malfunctions Replace the remote control batteries.
Clean the upper edge of the remote control (transmission window).
Check the battery terminals.

‘Check signal cable.’ message is 

displayed

Check that the signal cable is firmly connected to the PC or video sources.
Check that the PC or video sources are turned on.

On PC mode, ‘Not Supported 

Mode.’ message is displayed

Check the maximum resolution and the frequency of the video adaptor.
Compare these values with the data in the Display Modes.

The damaged picture appears in 

the corner of the screen

If Screen Fit is selected in some external devices, the damaged picture may appear in the corner of the 
screen. This symptom is caused by external devices, not TV.

The ‘Resets all settings to 

the default values.’ message 

appears.

This appears when you press and hold the EXIT button for a while. The product settings are reset to the 
factory defaults.

You may see small particles if 

you look closely at the edge of 

the bezel surrounding the TV 

screen.

This is part of the product’s design and is not a defect.

This TFT LCD panel uses a panel consisting of sub pixels (6 220 800) which require sophisticated technology to produce. 

However, there may be few bright or dark pixels on the screen. These pixels will have no impact on the performance of the 

product.

¦

N

2009-02-13    9:52:46



English - �0

Specifications

Model Name LE32B��0, LE32B��1
LE32B��2, LE32B��3

LE3�B��0, LE3�B��1
LE3�B��2, LE3�B��3

Screen Size 

(Diagonal) 32 inches 37 inches

Power Consumption

Standby <1W <1W

PC Resolution

(Optimum) 1920 x 1080 @ 60 Hz 1920 x 1080 @ 60 Hz

Sound

(Output) 10W X 2 10W X 2

Dimensions (WxDxH)

Body

With stand

803 X 77 X 545 mm
803 X 239 X 601 mm

927 X 78 X 608 mm
927 X 255 X 668 mm

Weight

With Stand 14 kg 17 kg

Environmental Considerations

Operating Temperature

Operating Humidity

Storage Temperature

Storage Humidity

10°C to 40°C (50°F to 104°F)
10% to 80%, non-condensing
-20°C to 45°C (-4°F to 113°F)
5% to 95%, non-condensing

Stand Swivel

(Left / Right) -20˚ ~ 20˚

Model Name LE40B��0, LE40B��1
LE40B��2, LE40B��3

LE4�B��0, LE4�B��1
LE4�B��2, LE4�B��3

Screen Size 

(Diagonal) 40 inches 46 inches

Power Consumption

Standby <1W <1W

PC Resolution

(Optimum) 1920 x 1080 @ 60 Hz 1920 x 1080 @ 60 Hz

Sound

(Output) 10W X 2 10W X 2

Dimensions (WxDxH)

Body

With stand

995 X 79 X 650 mm
995 X 255 X 706 mm

1126 X 79 X 730 mm
1126 X 277 X 783 mm

Weight

With Stand 19 kg 25 kg

Environmental Considerations

Operating Temperature

Operating Humidity

Storage Temperature

Storage Humidity

10°C to 40°C (50°F to 104°F)
10% to 80%, non-condensing
-20°C to 45°C (-4°F to 113°F)
5% to 95%, non-condensing

Stand Swivel

(Left / Right) -20˚ ~ 20˚

Design and specifications are subject to change without prior notice.

This device is a Class B digital apparatus.

For the power supply and Power Consumption, refer to the label attached to the product.
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Warning! Important Safety Instructions

Please read the appropriate section that corresponds to the marking on your Samsung product before attempting to install the product.

CAUTION

RISK OF ELECTRIC SHOCK DO NOT OPEN

CAUTION: TO REDUCE THE RISK OF ELECTRIC SHOCK,  

DO NOT REMOVE COVER (OR BACK). THERE ARE  

NO USER SERVICEABLE PARTS INSIDE. REFER ALL  

SERVICING TO QUALIFIED PERSONNEL.

This symbol indicates that high voltage is present 
inside. It is dangerous to make any kind of contact 
with any internal part of this product.

This symbol alerts you that important literature  
concerning operation and maintenance has been 
included with this product.

The slots and openings in the cabinet and in the back or bottom are provided for necessary ventilation.  
To ensure reliable operation of this apparatus, and to protect it from overheating, these slots and openings must never be blocked or 
covered.

Do not cover the slots and openings with a cloth or other materials.

Do not block the slots and openings by placing this apparatus on a bed, sofa, rug or other similar surface.

Do not place this apparatus in a confined space, such as a bookcase, or built-in cabinet, unless proper ventilation is provided.
Give your product 10 cm (4 inch) clearance from the wall.

Do not place this apparatus near or over a radiator or heat resistor, or where it is exposed to direct sunlight.

Do not place heat generating items such as candles, ashtrays, incense, flammable gas or explosive materials near the product.
Do not place a water containing vessel on this apparatus, as this can result in a risk of fire  or electric shock.
Do not expose this apparatus to rain or place it near water(near a bathtub, washbowl, kitchen sink, or laundry tub, in a wet 
basement, or near a swimming pool etc.). If this apparatus accidentally gets wet, unplug it and contact an authorized dealer 
immediately. Make sure to pull out the power cord from the outlet before cleaning.

This apparatus use batteries. In your community there might be regulations that require you to dispose of these batteries  properly 
under environmental considerations. Please contact your local authorities for disposal or recycling information.

Do not overload wall outlets, extension cords or adaptors beyond their capacity, since this can result in fire or electric shock.
Power-supply cords should be routed so that they are not likely to be walked on or pinched by items placed upon or against them, 
paying particular attention to cords at plug end, adaptors and the point where they exit from the appliance.

To protect this apparatus from a lightning storm, or when it is left unattended and unused for long periods of time, unplug it from the 
wall outlet and disconnect the antenna or cable system.  
This will prevent damage to the set due to lightning and power line surges.

Before connecting the AC power cord to the DC adaptor outlet, make sure the voltage designation of the DC adaptor corresponds to 
the local electrical supply.

Never insert anything metallic into the open parts of this apparatus. Doing so many create a danger of electric shock.

To avoid electric shock, never touch the inside of this apparatus. Only a qualified technician should open this apparatus.
Make sure to plug the power cord in until it is firmly inserted. When removing the power cord, make sure to hold the power plug 
when pulling the plug from the outlet. Do not touch the power cord with wet hands.

If this apparatus does not operate normally - in particular, if there are any unusual sounds or smells coming from it
unplug it immediately and contact an authorized dealer or service center.

Be sure to pull the power plug out of the outlet if the TV is to remain unused or if you are to leave the house for an extended period 
of time (especially when children, elderly or disabled people will be left alone in the house).  

Accumulated dust can cause an electric shock, an electric leakage or a fire by causing the power cord to generate sparks and heat 
or the insulation to deteriorate.

Be sure to contact an authorized service center, when installing your set in a location with heavy dust, high or low temperatures,high 
humidity, chemical substances and where it operates for 24 hours such as the airport, the train station etc. Failure to do so may 
cause serious damage to your set.

Use only a properly grounded plug and receptacle. 

An improper ground may cause electric shock or equipment damage. (Class l Equipment only.)

To disconnect the apparatus from the mains, the plug must be pulled out from the mains socket, therefore the mains plug shall be 
readily operable.

Do not allow children to hang onto the product.

Store the accessories (battery, etc.) in a location safely out of the reach of children.

Do not install the product in an unstable location such as a shaky self, a slanted floor or a location exposed to vibration.
Do not drop or impart any shock to the product. If the product is damaged, disconnect the power cord and contact a service center.

   WARNING - TO PREVENT THE SPREAD OF FIRE,  
KEEP CANDLES OR OTHER OPEN FLAMES  
AWAY FROM THIS PRODUCT AT ALL TIMES.
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Wiring the Mains Power Supply Plug (UK Only)

IMPORTANT NOTICE 
The mains lead on this equipment is supplied with a moulded plug incorporating a fuse. The value of the fuse is indicated on the pin 
face of the plug and, if it requires replacing, a fuse approved to BSI1362 of the same rating must be used.

Never use the plug with the fuse cover omitted if the cover is detachable. If a replacement fuse cover is required, it must be of the same 
colour as the pin face of the plug. Replacement covers are available from your dealer.

If the fitted plug is not suitable for the power points in your house or the cable is not long enough to reach a power point, you should 
obtain a suitabl y approved extension lead or consult your dealer for assistance. However, if there is no alternative but to cut off the 
plug, remove the fuse and then safely dispose of the plug.

Do NOT connect the plug to a mains socket as there is a risk of shock hazard from the bared flexible cord.

IMPORTANT 
The wires in the mains lead are coloured in accordance with the following code: 
BLUE - NEUTRAL BROWN - LIVE 
As these colours may not correspond to the coloured markings identifying the terminals in your plug, proceed as follows : 
The wire coloured BLUE must be connected to the terminal marked with the letter N or coloured BLUE or BLACK. The wire coloured 
BROWN must be connected to the terminal marked with the letter L or coloured BROWN or RED.

WARNING: 
DO NOT CONNECT EITHER WIRE TO THE EARTH TERMINAL, WHICH IS MARKED WITH THE 
LETTER E OR BY THE EARTH SYMBOL , OR COLOURED GREEN OR GREEN AND YELLOW.

Warranty Card

UNITED KINGDOM

This Samsung product is warranted for a period of twelve (12) months from the original date of purchase, against defective materials 
and workmanship. In the event that warranty service is required, you should return the product to the retailer from whom it was 
purchased. However, Samsung Authorised Dealers and Authorised Service Centres in other EC Countries will comply with the warranty 
on the terms issued to purchasers in the country concerned. In case of difficulty, details of our Authorised Service Centres are available 
from:

Samsung Electronics U.K. Ltd.
Customer Care Centre

PO Box 1�243
Edinburgh, EH11 4YB

United Kingdom
Tel: 0�4� SAMSUNG (�2����4) (UK & Northern Ireland)

Tel: 0�1� �1� 100 (EIRE Only)
Fax: +44 0�4� ��0 �0�0

Web : www.samsung.com

WARRANTY CONDITIONS

1.	 The warranty is only valid if, when warranty service is required, the warranty card is fully and properly completed and is presented 
with the original invoice or sales slip or confirmation, and the serial number on the product has not been defaced.

2.	 Samsung’s obligations are limited to the repair or, at its discretion, replacement of the product or the defective part.

3.	 Warranty repairs must be carried out by Authorised Samsung Dealers or Authorised Service Centres. No re-imbursement will be 
made for repairs carried out by non Samsung Dealers and, any such repair work and damage to the products caused by such 
repair work will not be covered by this warranty.

4.	 This product is not considered to be defective in materials nor workmanship by reason that it requires adaptation in order to 
conform to national or local technical or safety standards in force in any Country other than the one for which the product was 
originally designed and manufactured.

Warranty Card.indd   50 2009-02-13    11:41:05



Correct Disposal of This Product (Waste Electrical & Electronic Equipment) 
(Applicable in the European Union and other European countries with separate collection systems)

This marking on the product, accessories or literature indicates that the product and its electronic accessories (e.g. charger, headset, USB cable) should not be 
disposed of with other household waste at the end of their working life. To prevent possible harm to the environment or human health from uncontrolled waste 
disposal, please separate these items from other types of waste and recycle them responsibly to promote the sustainable reuse of material resources. Household 
users should contact either the retailer where they purchased this product, or their local government office, for details of where and how they can take these items 
for environmentally safe recycling. Business users should contact their supplier and check the terms and conditions of the purchase contract. This product and its 
electronic accessories should not be mixed with other commercial wastes for disposal.

[English]
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